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Section 1 – Introduction
Video: Welcome and Overview
Alan: Hello, and welcome to this Power BI introduction course. My name is Alan Murray. I am
an Excel and Power BI instructor, and I will be taking you through this course. We have plenty
to cover, so let's have a look at that.
The introduction section will see us installing Power BI Desktop, and having a quick orientation
to the screen and some typical default settings. We will then start to look at building our Report,
which we will do throughout the course, the first thing we need to do is get some Data and
transform and shape it ready for modeling. Once that's done, we will start relating the tables, we
need to create a Data table, and also choose which fields we will be using in our Report. Then it's
on to creating some DAX measures. We will be using some DAX in the third module and Data
modeling.
But in module four, we start to get a little bit more involved. Then it's on to add in the
Visualizations to our Report, which is something that really separates Power BI from Excel, lots
of Visualizations that we can use. We will be bringing them into our pages of our Report, and
looking at some of the formatting options available for them. Then we'll talk about some aspects
of Report design. There are some simple things we can think about to improve how a Report
looks and feels. And also, some built-in settings in Power BI Desktop that we can take advantage
of.
Next up is the Interactions and the Filters. We have a lot of options at our disposal, we will be
looking at some of the more popular ones, seeing how they're different, and how they can be
used to make our Report work the way we want it to. Then finally, we publish our Report to the
Power BI Service. And we also explore other ways that we could share this Report with others,
and also how we can access our own Report from remote locations.
So, lots of exciting content to talk about. Let's move into the next lesson, where we go into a
little bit more detail on what is Power BI.
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Video: What is Power BI?
Alan: What is Power BI? Power BI is a self-service BI solution provided by Microsoft. It is
aimed at the end user who doesn't necessarily have a technical background and know about
Databases or has experience in programming. It takes the hands out of the IT department, or the
need to hire a freelancer, and enables that general end user who may have a background in Excel
to be able to create powerful and interactive Reports.
There are two parts to Power BI; there is the Power BI Desktop, which will form most of this
course, that is the software where we create our model and our Reports. And then there is
powerbi.com, otherwise known as the Power BI Service, which is where we publish our Reports.
And we can create dashboards and share it, we have our audience. It contains functionality for
users to be able to interact with our Reports, but nowhere near the features that we will have in
Power BI Desktop to actually create them. So what makes up Power BI?
Well, first of all, it has Power Query. Some of you may have experienced of this through Excel.
And that will be an advantage to you if you do. It's the same feature, and it's available in Power
BI for us to import Data from a huge variety of sources. There are many connections available,
and more coming out as we speak. We can use Power Query to transform and shape that Data
ready to be loaded into the model.
Once it's in the Data Model, we can create our relationships between our tables, which is a much
more efficient and effective way of modeling our Data versus the classic Excel approach, where
we would have one large table and we would use formulas like V-lookup to fetch Data from
other places, and bring them into that one list ready to analyze.
In Power BI, we will be focusing on coming away from that flat file, that one big list, working
with separate tables and relating them. This means we can work with huge volumes of Data. We
also have DAX (Data Analysis Expressions), a very rich formula language that is constantly
growing and allows us, if needed, to create powerful calculations. We then have the powerful
Reporting features. There are a huge amount of Visualizations, and even more that we could
import into Power BI. And there are also many ways of interacting, filtering, and highlighting
different areas of our Reports.
These are all built-in, so they do not require huge technical skills to be able to operate. They are
fresh out the box so that we can create amazing Reports in just a matter of minutes. And then it
comes to distributing these Reports. And typically it will be published to the Service
powerbi.com for sharing, but it can also be embedded into a website and remain fully interactive,
and even more options, such as PowerPoint presentations, PDF, or even just sharing the Power
BI Desktop file itself. Just like you would share a Word document, a PDF or an Excel
spreadsheet already. So that is Power BI, let's get into the good stuff.
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Video: Install Power BI
Alan: Now that we have spoken about what Power BI is, if you don't already have the software,
the next step is to get it. Now one way that we can do that is navigate to this URL, or to simply
type Power BI Desktop into Google, and you will be taken to a page where you can download
the software ready for use. That's one approach, an easier way of downloading the software
would be to come into a Microsoft Store.
So if I click on my Microsoft Store from my Start button, and I can search for the Power BI
Desktop app in here, if I click my search button in the top right corner, type Power BI and give
the desktop a click. I already have this software installed, so I can see a Launch button where
there would have been an Install button if I didn't have this software. I can see that the product is
already installed on the left as well.
And by installing Power BI Desktop taking this approach, you can be confident that it will
constantly update with the new releases that come out regularly. If you're interested, you can also
scroll down and find a little bit more information here about what Power BI Desktop is. They
have some nice bullet points here. Mentioned about how you can extend your Data model with
DAX, and that they have over 100 cutting-edge visuals, and various information some of which
I've mentioned.
And also if you scroll down you can see some of the more technical details about how much size
this will take on your machine. But nice and simple. You can install Power BI Desktop from here
and follow along with this course.
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Video: Tour of Power BI
Alan: Let's have a quick little tour of Power BI Desktop before we get a grip of our Data, and
really start having some fun. Now, when you open up Power BI Desktop for the first time, you
will encounter this welcome screen. And I wanted to show this screen because it can be quite
useful. You have access to recent files that you've been using on the left, and the opportunity to
go and get new Data or use recent sources in Reports.
But more importantly, I think, especially when you're starting out is what's happening in the
yellow side, we have some video tutorials. But on the right hand side, we have access to what is
new, forums, to get assistance from the Power BI community, and also the Power BI blog. And
this is important because Power BI is updating very regularly. Every month, there are new
features to Power BI Desktop, and Microsoft will release a video to tell everybody about these
features.
But because it is a fast evolving software, although that's brilliant as a user that we're getting a
more efficient and more powerful piece of software, it does mean that we need to be aware of
what's changing. So that, if one of our favorite buttons suddenly moves, we know that and we
can find it again. Or if there's a new DAX function that's better than the old one, we want to
know about it. If you do not want to see this screen anymore, there is a nice tick box at the
bottom. So we can ask it not to show this again on startup.
But maybe you want to bookmark some of those links first. I can see my name in the top right
corner because I am signed in with my Microsoft account. If I close this welcome screen for
now, this is Power BI Desktop. We have a Ribbon along the top, just like any other Microsoft
product, although some of them may have a different name, such as Modeling. Now we have a
View Tab just like any other application, also an Insert and a Home Tab most important of all, on
the left-hand side, we have three different views.
We have a Report view, which is the view we are on at the moment. And that is illustrated by
that small yellow bar. And a Report view is literally a blank canvas, so that we can insert and
arrange our Visualizations and other tiles into a stunning looking Report. It has some pages at the
bottom, just like you would have different sheets of an Excel workbook. And we start off with
one page to our Report. And on the far right-hand side, there are three different panes by default,
there is a Filters pane with some really useful filtering options that we will be looking at. We
have a Visualizations pane with access to a variety of visuals, such as Cards and Charts, and
Maps and Slicers.
Underneath that, we have a Fields and a Format in icon that will provide options for us to work
with those Visualizations. And this is all theoretical at the moment. But we will be getting our
hands on those very soon. We also have a Fields pane. And for those of you with some
experience of pivot tables in Excel, that will look very familiar. Coming back to the left-hand
side, that was the Report View. But we also have this Data View. And at the moment, it does not
look like much because we don't have any Data. But you will see a Formula Bar along the top,
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which you'll recognize. And when we do have Data this will look like Excel, we will see our
Data structured as a table.
We also have a Field List on the right hand side, just like the previous view. We then have this
Model View and this is a really useful view. Once again, it doesn't look like much although we
do have a nice diagram, illustrating what it's used for. And we will primarily be using this view
to establish the relationships between our different tables and to be able to manage them moving
forward. But there's also a lot of other cool things we can do in this view. And over on the righthand side, we have the Fields pane again.
And we also have a Properties pane, which we will be using in this course. I'll come back to the
Report View, which is the main view of Power BI Desktop, but all three of those have their uses,
and we will be making the most of them. Before we go any further, I'm going to save this blank
file ready for when we start importing our Data and creating our model.
So just like any other Microsoft file, I can click on File and Save As and from this typical
looking Save As screen, I will navigate to the Documents folder where I'm going to save this,
give it a nice file name such as power-bi-course. And you can see it has a .pbix extension. So a
Power BI file is just like any other file and anybody I share it with can also open it in Power BI
Desktop. If I click on Save and we have our new Power BI file ready to work with
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Video: Power BI Options
Alan: Hello. In this lesson, I wanted to explore some of the default Power BI options, and those
have particular interest. So if I click on File, and come down to Options and Settings, and then
from here, Options, and there's quite a lot to see in here, but I wanted to look at three different
categories.
And I wanted to begin with the Preview Features in this Global section. So any changes we make
here affects your Power BI Desktop installation, and how any files that you create will behave.
And if I click on Preview Features, this is what it looks like at the time of recording, which is
April 2020. And I've already mentioned in a previous lesson, how Power BI is constantly being
updated. So you can see that I have three features enabled here, and others that I have not.
But these are features that are available for us to try, and they may even change or be removed in
future releases, in future updates of Power BI. And I wanted to bring your attention to this.
Because one, at a time of you watching this video, things may have changed. Or you may not be
seeing, for example, a ribbon that looks like mine. But I am previewing the updated ribbon. So
please expect some changes over time because they are happening for the good. But also, this is
an area you can come if you're interested in using some of these features in Preview.
Now further down this Options window, we have the Settings for the current file. So any changes
in here will only affect this Power BI course file that I saved in the previous lesson. And there's
two categories I'm interested in here. One is Data Load, where we have a few checkboxes that
are quite commonly referenced by Power BI users. The first one is the Type Detection. And this
is Power Query, which we're going to see in the next module of this course. And Power Query
by default, automatically detects column types. And it's very good at doing that. So it can be
useful. But some people also find it frustrating. So it's quite common for people to come here and
uncheck that box.
However, I'm going to leave that one checked, so that we can see that in action, especially for
those of you who may not be so familiar with Power Query. Now in the next section down, we
have some settings on relationships. And I am going to uncheck the auto detect new relationships
after the Data is loaded. Once again, Power BI is very good at doing that; very effective at
working out the relationships that need to be there. However, I don't want it doing it here. I'm
interested in us getting our hands on and creating those relationships ourselves.
The next category is the Regional Settings. And in here, I am set as English United Kingdom,
because that is where I reside. But this is the locale for how Power BI interprets your numbers,
your dates, and your times. Now I'm going to leave mine as English UK. But it's worth bearing in
mind that just because you might reside in the UK, or the US or wherever else, that may not
necessarily be the Data you work with. Now, this is something we can still change in Power BI.
So it's not that important that we modify this Setting, because we could change the locale after
import.
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But if you're regularly receiving Data from other countries, so for example, if I'm regularly
receiving Data that's constructed in the US date format, or in a European number format, it
would make sense for me to change this setting to work with that Data. Because just because I'm
in the UK doesn't mean my Data is being structured in a UK format, and that would save me
some time and potentially some issues.
So they are three different categories in here. But there's quite a few options that you might be
interested in tweaking for your Power BI experience. I'll click Ok to confirm the changes that I
have made, and let's progress into getting some Data.
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Section 2 – Import
Video: Import from Folder
Alan: It is now time to get started on our Reports. And the first thing we need to do is get some
data. And in this first example, I'm going to import multiple CSV files from a folder. And these
CSV files contain Sales Data.
So the scenario here is that we have a coffee shop, and we have multiple shops around the world
in different Locations. And the transactional data is in these files. So this is the folder called
Sales. And it's in My Documents folder. But for you, it will be wherever you have downloaded
and saved this material. You can see in here that we have four files, all of them are CSVs. And
they have a consistent naming of Sales and the year. So we have four years’ worth of random
and fictional data.
Back into Power BI. On the Home tab, if we click on Get Data, this will drop down a list of
common Data Sources. And Folder is not on that list. So if I click on More, this will expand into
a window with the complete list of Data Sources. Now we have different categories down the
left-hand side. But if I just scroll down this All list for a moment, you can see the volume of Data
Sources that you can use in Power BI. And this is constantly growing. We can see PDF in here.
And as I move down some very common Data Sources that you may use, or at least be aware of.
So we have Google Analytics, a LinkedIn Sales Navigator, GitHub, and the list goes on and on.
So this is really cool, and you might find the software that you use in here, ready to rock. If I
scroll back up because Folder was near the top of the list, I'll select that and click Connect. First
of all, it will ask us to browse or provide the path for that folder. Now mine is on the Documents
folder. So if I click on Browse, and expand Libraries, I can choose documents, scroll down a
little bit, and there is my Sales folder.
If I click Ok, the path is put into that folder path Field and clicking on Ok will now connect to
that. And we see a window listing all of the files that it can find in that folder. Now in this
example, it is only the CSVs. At the bottom, there are a few buttons for some actions, it is always
encouraged to go straight for Transform data. We will be combining it very soon. But it's always
a good habit to click on Transform data so you get the opportunity to look at it before you start
taking any major steps. We now see the list of files in the Power Query editor.
Now, we are not going to spend a huge amount of time on Power Query in this course. For that,
if you're new to this tool, you will need to find yourself a Power Query course for some more indepth information. We will be covering a variety of transformations in Power Query features
over the next few lessons. But it's a much larger tool than what we can go into any serious detail
in this course. But at this point, if there were files in that folder that we did not want to use, we
could filter them out, maybe using the extension column to avoid any PDFs or Excel workbooks
that might be in here.
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For us, we are going to combine it this is exactly what we want. And there's a button, a double
arrow button in the header of the content column. And if I click on that, it’s going to open up all
four of those files and stack them into one big list. We get this window first giving us an insight
to those files. We are happy with this. If I click Ok, it's going to take a little while to combine
those and we get that complete list. We have the name of the file in the first column. And then
we have the Order ID, the date of the transaction, the Sale, we have the Product, and also in the
same column, the name of the shops’ Location, and then the Country code for the Country that
that shop resides in, where that Location is found in. We then have the old imported amount.
Now the file name in the first column can be very useful in analysis sometimes. But for us right
now, it's not needed, I don't need the year and its name, because I have the year in the Date Field.
So I'm simply going to right-mouse click on that column and remove it. Now in Power Query, on
the right-hand side, as we go through these transformations, we have an Applied Steps pane
listing every step that we take. So in the future, when we have our Report go in, we can just
refresh this and every step is updated. Power Query is absolutely amazing.
Now, there's a lot of steps in a moment, we don't need to worry about any of them really, apart
from the Source. And then the Remove Columns, which we just performed ourselves. Because
those steps were done by the importing from a folder, and then combining to one list. And Power
Query did it so that we don't have to worry about it. If I was to make a mistake, and I realized
that I don't want to remove that column really, I could just click on that small black X next to
that step, and it is removed. And that is your Undo button of Power Query.
On the far left, we have a Queries pane. And once again, there's a lot of queries because Power
Query generated those when it combined the files. The only one that we're interested in as part of
this course, because we can't go into that detail is the Sales Query. Now to carry on through
some transformations, we can see we have a Product column, and we need to separate the
Product Name and the Location of the shop. So I'm going to select the Product column. And
from the Home tab, click on Split Column. There are really cool options in here. But we want By
Delimiter.
It automatically assesses the column and assumes we want that open bracket, which we do, but
I'm going to put a space before it as well. So it removes that space between the Product Name
and the bracket. We then get the option to where to split it at. Will it be each occurrence? I'm
going to change that to Right-most delimiter. In this example, it shouldn't make any difference.
In fact, I know it makes no difference, because there are no other brackets in that column. But
I'm choosing Right-most delimiter because if it was to suddenly become an issue, I know the
Locations on the end of the column, therefore it will be the right-most.
Click Ok will perform that split and produce a new column as a result, we now have a Product
column and this Location column. Now I want to remove that close bracket from the Location.
So if I select that column, and there's a button called Replace Values nearby that Split Column
button. In here, I will ask it to replace the close bracket with nothing and click Ok, and that
bracket is removed. As we go through these steps, on the right-hand side, you can see all the
Applied Steps taking place. And you may remember from the previous video on Power BI
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options, where there was an option to auto detect the Data Type. And you can see in Applied
Steps, I have two Change Type steps.
Nothing that serious. But that was that setting automatically generating these Data Type changes.
And that's why some people like to disable that so you don't get too many of those. But they’re
often there, they’re not doing any harm, and I wanted us to see that. I'm now going to rename
those columns by double click on the first one and call it Product and then double click on the
second one and call it Location. Now I'm going to double check the Data Types myself. So
although they auto detected it, they may not have it correct.
Now the first column, you can see a small icon indicating 1, 2, 3 that that is storing Whole
Numbers. And that's great. The second column has a date icon. So that's a date. In Product, we
have Text and Location is also Text, as is the Country code, all of them perfect. Now the final
one for Amount, that 1.2 indicates a decimal value, which the amount is. But I'm going to click
on that little icon because it's actually a button, and that allows us to change that Data Type. And
I'm changing it to a fixed decimal, so that when I click on that, all of the results have two
decimal places, is fixed. That now means we have three Change Type steps on the right-hand
side.
The final step in here for the moment is going to be to rename this Query. In the Properties pane
on the right is named Sales. I'm going to rename that as SalesPrep. Because this is not actually
the finished result yet. In a couple of lessons time, we're going to work off this Query. This is
just the initial preparation. It’s not perfect for us yet. So I've named it SalesPrep. And now I'm
going to Close and Apply to load this into our Power BI Model. Close and Apply is on the Home
tab on the very far left.
If I click on that, it will take a little while here, just to load this into our Model, because it's quite
a large set of data. And here we have it. On the Fields list on the right, we can see all the data is
loaded. We have our Sales Prep Table, and then its Fields. We have a calendar icon next to the
Date Field, and we have this sum icon, this sigma indicating the Numeric Fields from that Query.
Now that is a little over a million rows of data. Just to quickly show that off with the first Visual
of this course.
In its Visualizations area if I click on a Card icon, that will dump this Card tile into our Report.
And I'm going to drag the Order ID Field into this Field area to its left. That will count the Order
IDs by default, just to show that we have loaded 1.2 million rows of data from those four CSV
files.

© Copyright 2008-2021 Simon Sez IT, INC. All Rights Reserved.

Power BI

Video: Get Data Excel and Text
Alan: In this lesson, we are going to import data from two more sources. Now the first source
will be an Excel workbook. So from the Home tab, I have an Excel button on there, ready to be
used. So if I click on Excel, the open window appears and is on my Documents folder. I can now
scroll to the workbook that I need, which is this one called Countries.
If I select Countries and click Open, it connects to the Excel workbook and takes me to this
Navigator window, listing all of the elements within it. And I can see that there is a Table named
Country, and also a sheet named Sheet 1. Now if I was to select the Country Table, I will see a
preview on the right-hand side. And as you would expect, it is some information about countries.
A nice simple Table here, but there could have been lots of Fields with information about these
countries. And these are the Countries referenced from the Sales Data we imported in the
previous lesson.
If I click on the sheet, I also get a preview of that. And these two elements are showing me the
exact same set of data. Now because I have that data in a Table already, it makes sense for me to
choose the Table over the Worksheet. But we could have imported data from a sheet. If I click on
Transform data at the bottom, I am pretty confident that this data is ready to be used. But it's
always a good practice to click on Transform data and check your data out before you load it.
So here it is in the Power Query editor, the Query is added to the left-hand side in the Queries
pane. And over on the right-hand side, we have the Applied Steps, and we have the name of the
Query. I'm just going to put a capital C in the Query name there. And in the Applied Steps, you
can see the connection to the Source, the Navigation to the Table, and then the auto detection of
Change Type. Which if we look at our data, both columns are Text Data Types. And that's
correct. So this Query is already ready to be used, no transformations or any other data shaping
required.
Now I'm going to stay within the Power Query editor. And I'm not going to load this to Power BI
yet, because there is another data source that we want to connect to. And this one is a Text file.
So from within Power Query, I can click on the New Source dropdown on the Home tab, and I
can see Text is an option from this list. But just like in the previous lesson, if I needed to connect
to a folder, or to a PDF, or something that is not listed in this quick fire list, I can click on More
to get that large, complete list that we saw. I'm going to click on Text/CSV. That will take me to
the Documents folder. And this Products file is the one that I want to use.
So after selecting I’ll click Open. I have this preview of the Text file showing me the ID of the
Product, its Name, and then a Category that it has been assigned to. Looks great. I'll click on Ok.
And now it's into Power Query, where if needed, I could perform some transformations. But just
like with the Excel workbook, this looks good. On the right-hand side, I will capitalize the name
of Products. And once again, the Applied Steps, the Source, the Promotion of the headers and the
net Change Type step.
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Now when you're looking at these Applied Steps, you can click on them to see what your data
look like at that point in time. So I could click on that Source step and in my Formula bar above,
I can see the file path of that Products file. So if I ever needed to change that for any reason, if
that file was to be moved, then I can do so at that Source step. And I don't need to recreate this
connection all over again. There is also a Gear icon to the right of that step name. And rather
than editing it in the Formula bar, I could click on that Gear icon, and it would take me to this
window where I could then browse for where my new file or where that file may have been
moved to.
I can click on Cancel for now, not all steps in the right have a Gear icon for simple editing. But
some of them do. And that can be really useful so that you don't have to redo those steps. As I
mentioned, because that Source is selected, we are looking at our data in that point in time. So if
you look at the data in the middle, you can see the headers are in the first row and not in the
header.
But then the next step is that Power Query automatically promoted them into the header area.
And now in the data, we can see there in the headers. And then it applied the Change Type step,
which in this example, was simply to change the ID into a Whole Number. It's always good
practice to check those Data Types. And all three of them are good. We have a Whole Number,
Text, then another Text Field. So I'm happy with this.
From the Home tab, we can click Close and Apply to close the editor, load this data into Power
BI. And here we have it on the right-hand side in the Field list. We now have those three Tables;
Country, Products, and Sales Prep.
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Video: Reference Queries
Alan: In this lesson, we need to normalize our Model. Let's have a look at what I mean. On the
Home tab of Power BI, if I click on Transform data, this will reopen the Power Query editor, so
that we can see the three queries we currently have, which is Sales Prep, Country, and Products.
Now, Sales Prep is our transactional Table, otherwise known as the Fact Table, or the Data
Table. This is our large 1.2 million rows of Sales over these four years. Now, you want to keep
these Tables as skinny as possible, they're going to be long, especially if you're successful,
because we're going to have many Sales. But we want as few columns as possible. Now looking
at this Table, we have a Product Location and Country code columns.
Now the Country code column is not necessary. We don't want it in here, because we have a
Location, and we can find the Country through the Location. The Product and the Location we
do. However, I would like to use some Index Numbers there as a reference to the Product and
Location and not the names of them. This will make our Fact Table fast to interrogate through
our DAX formulas and Visualizations.
So I want to create a Location Table. We don't have one at the moment, we have Country, we
have Products, we don't have Location. So in the Queries pane on the left, I'm going to rightmouse click on Sales Prep. And there is an option to Reference this Table. There is an option for
Duplicate and an option for Reference. Both of them would work, but it would be better to
Reference this Query, because Duplicate would duplicate all of those transformation steps, plus
the connection to the source folder that Query does. If I Reference it, I get another Query from
that. But only one of them is connected to that source folder.
Now with this new one, I'm going to immediately rename it by right-mouse clicking again and
renaming. And it's going to be called Location. And you can see in the Formula bar, that the
source is just a reference to the other Query, = SalesPrep. Now if we look at the data, we want
this Table to be about Location. So I'm going to select the Location column and hold down
Control to select the Country column. And with them both selected, I will right-mouse click and
Remove Other Columns. So that we are just left with the Location and the Country code.
Now that we have this, I want to remove the duplicates from Location, because at the moment,
we still have those 1.2 million odd rows. So with Location selected, on the Home tab, there is a
Remove Rows button. There are really good options in that dropdown. The one we want,
Remove Duplicates, will strip out all the duplicate mentions of a Location, leaving us with our
48 Locations. Now that we have that, I want to select the Country code column, so that next to
Remove Rows, I can sort the Country code in ascending order; giving us Australia and Austria at
the top. Now the Location names in this example are unique. There's no duplications. Although
that is something that can happen.
There are towns and cities across the world which share the same name. Here they are unique,
but it's good practice to have an Index Number as a unique identifier. Often your data will
already have this index. It will have an Employee Number or Product code that's typically
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generated by a system. Here we don't have that. So I'm going to click on the Add Column tab and
then the dropdown arrow for Index column, so that I can insert an Index Column starting from 1.
That will include it at the end of our data set. Here it is.
So my next step is to click and drag it to the start, it's always nice to have your Key Field as the
first column. I'm going to change its name, the header to Location ID as a more creative name
than Index. And then our final step really is just to double check those Data Types like we do. So
the first Data Type is a Decimal Number. Now, these are whole numbers. So I'm going to click
on that and change it to Whole Number. And then Location and Country code are Text Data
Types, which is great.
So all of these steps, just like the previous queries have been added in Applied Steps on the right.
So if we ever refresh this data, the data will come in from the files in that folder into Sales Prep,
transformations happen, and then this Query is linked to that one, so that then this Table is
generated. So now we have our Location Table. Let's click on Home and then Close and Apply
to load it into the Power BI Model. And there it is in the Field list on the right-hand side.
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Video: Merge Queries
Alan: Now that we have that Location Table, we want to create a new and improved Sales Fact
Table. So let's begin by clicking Transform data to bring us back to the Power Query editor. And
we're going to do this by using Merge Queries, a brilliant feature of Power Query.
And on the Sales Prep Table, up in the Home tab, Merge Queries is on the end. And I want to click
the dropdown arrow, so that I can specify to Merge Queries as a New Query. I don't want to affect
the current Sales Prep Query. Because my Location Query is referencing it from the previous
lesson. I want a new Query, which will be our Sales Fact Query.
Now in the Merge window, I have the Sales Prep Table selected, because I began the Merge Query
from it. But then I have this dropdown list where I can specify the Location Table. So what I want
to do here is bring in the Location ID, from the Location Query or Table. So that in the Sales Table,
I can remove the Location column, and also the Country column. And the Location ID will be used
to reference that data.
So in the first Query, I'm going to select the Location column. And then in the second one, select
the Location column. Because at the moment that is being used to join, or to identify the data in
the two Tables. And the bottom of the window is just estimating my matches. And has confirmed
that we have a complete match. Now there are different Join Kinds available in here, which is not
something we're going to get into detail with now. That information will be provided by a more in
depth Power Query course. But this is a very powerful feature with six different Join Kinds. For
us right now, the Left Outer Join is what we need. So if I click Ok, that will perform the merge
and bring the Location Table into this new Query.
Now with this Table in the header, there is a button to expand the Table data. So if I click on that
button, it will ask me what Fields from that Table would you like. Now we just want Location ID.
So I'm removing Location, removing Country code, and also removing the original Column name
as a prefix. If I click Ok, the Location ID is brought into this Table. Here it is. So I'm going to click
and drag that column into position. And then I can select the Location column, hold Control, and
select the Country code column, right click, and remove them.
Because now I have that index that ID, I can use that to reference the data in the other Tables. I
don't need them in this big over 1 million row Fact Table. This is good practice. Keeps our Model
small and also efficient in respect of our speed of calculations. I now want to repeat that process
for the Product. I have a Product Name in here, but I want to replace it with an Index Number. So
this time, I'm going to click on the Merge Queries button. I don't want a new one. This time I'm
changing the existing Query. So if I click Merge Queries, it will open this Merge window again,
the current Merge 1 Table is selected.
From the dropdown, I'm choosing Products. And the match will be the Product column in the first
Table, Product column in the second Table, and that should return a complete match, there it is.
I'll click Ok to bring that Table into this Query, expand the Table and bring in only the ID column
by clicking Ok. And then drag ID before Product, it's not necessary to order these columns in this
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way, I just like the Amount column to be the one on the end. I can now remove the Product column,
because I don't need that anymore. That ID will be the reference to that information in the Products
Table.
I will rename that header instead of ID, which makes sense in the Products Table because it's about
Products. But now I'm in the Sales Table, I need to be more specific that that is the Product ID.
Otherwise, that could get very confusing. So now we have three ID columns in this Table. We
have the Order ID, the identifier of our orders. But then we have Product ID and Location ID,
which are going to become foreign keys for the Products and Locations Table. And we'll see that
when we're creating our relationships in a few lessons time, we definitely need to rename this
Query.
So on the right-hand side, Merge 1 is not very meaningful or creative. I'm going to call it Sales. So
now this is the Sales Table that we'll use. The previous one was just a staging step for the Location
Table and now the new Sales Table. If I click on Close and Apply to now load this data into our
Power BI Model.
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Video: Prevent Load
Alan: In this lesson, we are going to prevent our Sales Prep Table from being loaded into Power
BI. At the moment in the Field list on the right, we can see the Sales Table and Sales Prep. Now
we do not need them both. And although Sales Prep is not causing any harm, it is creating
unnecessary clutter and confusion. And also time loading that into the Model when we refresh.
So if I click on my Home tab, and Transform data, to go back into that Power Query editor, and
in the Queries pane on the left, I'm going to right-mouse click on Sales Prep and uncheck the
Enable load. I am warned about possible data loss, and then it may break Visuals in my Report.
But that's not going to be a problem. So I will click on Continue. And the Sales Prep Table on
the left is italicized, illustrating that it will not be loaded into the Model.
So it will still do all the Query steps here, everything will still function fine. And the Tables that
we've got referenced in it will function fine. It just won't be loaded into the Model which we're
going to work on over the remainder of this course. So if I click Close and Apply, bringing us
back to Power BI, and in the Field list on the right, we no longer have the Sales Prep Table.
Now on our Report page, I can now see something has gone wrong with our Visual, which is
what I was warned about with that possible data loss warning. So it was correct to warn me.
However, that Visual is the Card that we used in a previous lesson to check the number of rows
in our Sales Data, and I used the Sales Prep Table back then.
If I wanted to check it again now, I could select that Visual, and over on the right-hand side,
remove the current Field it's using which it cannot find because it's not loaded into the Model.
And I could open up the new Sales Table and move the order ID back into Fields. And now we
have the same result as earlier.
However, that's not a Visual we're going to use. So with it selected, I'm just going to remove it
by pressing Delete. And we have the data that we're now going to start working on in our Model
and ultimately, our DAX and our Visuals.
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Video: Practice Exercise
Alan: Hello and welcome to the practice exercise for the module on getting and transforming
data in Power BI.
Go ahead and open up file 2-6-practice-exercise and follow the instructions found on the
instructions page.
There is a completed version of this file named 2-6-practice-exercise-complete for you to check
your work against. Have fun.
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Section 3 – Create Relationships
Video: Create Relationships
Alan: It is now time to create the Relationships between the four Tables in our Model. At the
moment, if I was to try and create a Visualization, that includes data from different Tables, it’s
not going to work. Let me show you that.
In the Visualizations pane, if I bring in a Visual, such as a Table, if I click the Table to put that
tile onto my page. And then if I open up the Products Table, and I drag the Category Field into
the Values area, it successfully lists the three different categories of Product that we have. If I
then drag the Amount Field from the Sales Table into Values, it doesn't show me the correct
Value for each Category. You can see I've got the same number four times.
Now the Value for the totals correct 4.3 million, let's call it it’s a correct figure. But we've got the
same figure for the categories, it doesn't understand how to filter that total for Pastries, Food, and
Beverages. So it just shows the same total. Now that is because we don't have a Relationship
between the two Tables, providing that filter context through the Category and then into that fact
Table for the correct totals. So let me leave the Visual there. But switch to the Model view on the
left-hand side.
If I click on Model, here is our Model view. Looks a little bit messy to begin with. Because for
some reason, the Tables are always all over the place. So in addition to creating Relationships,
one of the first drops is to drag these into some kind of meaningful position. So I can just drag
them using their headers into view. Let me scroll over for the Sales one. And you can position
these how you like. But there are some quite common ways of positioning these Tables. And I'm
taking this approach of having the Sales Table, our Fact Table, our Data Table at the bottom.
And then the Lookup Tables, also known as your Dimension Tables up above.
Now, let me move Products over to the right, so that Location is next to Country, because they
are related, like this. And now we can create the Relationships. Now there's a few different ways
of doing this. But the easiest way is just a drag between the two Fields of the Tables. So for
example, to create a Relationship between Sales and Products, the common identifier is that ID,
or in Sales, it’s known as the Product ID. So from the Sales Table, I'll hover my mouse over
Product ID. So I have that gray background.
Click and drag up to the ID Column in Products, which is the unique identifier that we created,
and release my mouse. And there is the Relationship, we have a one-to-many Relationship from
the Products Table look up into the Sales Table. A Product can be sold many times. The ID is
unique in Products, but it's not in Sales. And we also have this arrow on the line indicating the
filter direction. So in the Visual that we created previously, it will filter the Category in Products
to Pastries, Food, and Beverages, and then produce the right total in Sales.
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So if we wanted to check that out now, if I switch back to Report view, it's working brilliantly.
We now have the correct totals. Let's go back into our Model view to create the other
Relationships.
So for this next one, I'm going to drag from the Location ID Field in Sales up to the Location
Table and it will correctly establish that there's a Relationship between Location ID and Location
ID. Once again, a one-to-many Relationship. It filters through Locations into Sales. I can then
create a Relationship between Location and Country. If I click and drag from Country code in
Location to Country code in Country, I now have a one-to-many Relationship there as well,
because a Country can have many Locations. Some of them only have one, most of them have
more than one Location.
If I hover my mouse over any of these Relationship lines, it highlights the two key Fields. So you
can do that to double check that Power BI is using the right Fields. You will certainly notice
when you try and use them in the Visual, like we have at the moment with our Category Sales. I
know this Product is working because of that Visual, but just hovering over is a nice peace of
mind illustration.
We also have a Manage Relationships button up on the Home tab. And if I clicked on that
button, this will also provide information on those existing Relationships. And also the
opportunity at the bottom to Delete, Edit, or even ask Power BI to Auto-detect them so that we
don't have to create them yourself.
But bear in mind, it might make mistakes. So it's nice to be hands-on and set this up. Because if
these don't work, then neither will our DAX or our Visualizations effectively. I'm going to close
this window and that is our Relationships, done.
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Video: Dynamic List of Dates
Alan: We have one more Lookup Table, which I would like to add to our Model, and that is a
Dates Table. There are three main reasons why your Model should have a Dates Table.
Reason number one is that whenever we use a date in a Visual, or in a DAX formula, Power BI
creates an invisible Date Table on the fly. Now, by creating our own Date Table, and marking it
as one, Power BI knows what to use. That then means that we can write more powerful DAX
time-intelligence formulas, because we will have the information to work with them. The third
reason is that by creating our own Date Table, we can create the Fields which we would like to
use in our Report.
At the moment, the only Date Column we have are the dates of the orders in a Sales Table. But
we might want to do analysis on the day of the week, or on a financial year. And this is
information which we don't actually have at the moment, we only have the Order Date. But we
can create these Fields, these Columns in our Dates Table, ready for the analysis. Now we are
going to create this Date Table using DAX, the data analysis expressions formula language.
So I'm going to click on the Data view. And in here, we are going to create a new Table. And
there's a button for New Table up on the ribbon, which as I move my mouse over, it tells me to
write a DAX expression to create the new Table. Let's give it a click. And it simply opens up the
Formula bar. Now, our Date Table needs to include every single date within the range that our
Model uses. So for example, we have the date in the Sales Table. There may be dates in that
Table where we didn't sell anything. But they must be included in this Date Table, every single
date within the range that our Model uses.
Our Model does not have any future dates, because we only have a date of a sale. But you may
be working with a Model that does have future dates, such as expiry dates of something, or
expected delivery dates. And we need to take this into account. So I'm going to write a DAX
formula to bring a list of every single date within all the years of our Model. Now I know that
this one goes from 2016 to 2019, because that's the data we imported earlier. But I want this to
be dynamic. When somebody adds 2020 as a CSV file, this formula has to pick up.
Let's start with the name of our Table. And I'm simply going to call it Dates =, and as soon as I
put that in, a list of DAX functions appear. I can also see the Country Table in that list. So we get
this IntelliSense list just like Excel when you're writing your formulas and functions. Now, DAX
is such a large and rich language, we are merely touching the fringes of it in this course. This is
not a DAX course, it's a Power BI course. So with that we're going to write some DAX here,
we're also going to do more in the following module.
In the grand scheme of things, it is just a finger prick of what is possible. The function we need
right now though, is one called CALENDAR. And this function returns a Table, which is
important because we're creating a new Table of all the dates between a Start Date and End Date.
So I'll press my Tab key to finish that off. Now a great thing in that Formula bar is that we can
zoom in, so it does appear a little bit smaller on your screen, I can hold down the Control key on
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the keyboard and roll my mouse wheel up. And that Formula bar gets larger and helps us see
what's going on a little bit easier.
Now the Start Date is what we need to find out. And I want this to be dynamic. I know it's 2016
in this example, but you may have Models that are rolling with time, and you need that
dynamism. So I'm going to start with the DATE function and open it up. So it prompts for the
year, month day, of the date. And for the year, I'm going to use the YEAR function of the
minimum date. So it's type Min, that will prompt me for a Column name of which to find the
smallest number, the minimum number. And I'm going to reference the Sales Table, and the
Dates Column.
Now, for any of you who have written Excel formulas, working with Tables in Excel before, this
is going to look very familiar. If you haven't, this may look a little bit different. There are
similarities. But there's also more differences to what you might be used to. So we have the Sales
Table, and then a Column name with square brackets around it. And that's notation. I'm going to
select that and then close off the Min function, return the smallest number, ie the earliest date,
another closed bracket for year to extract the year from that comma, then prompts me for the
month, the month is one comma, the day is one closed bracket for date.
So that is the first of January of the earliest year in our data set, I can now put in a comma, and
repeat that behavior for the End Date. But this time using the max function. So it's date, what's
the year, what’s the year of the maximum date from that Sales Date Column, comma, the month
is 12, the day is 31. And then I'll close off the DATE function and close off the CALENDAR
function. So I've given it a dynamic Start and End Date by simply finding the smallest and
largest numbers in the Dates Column and extracting the years from them. And there are various
techniques for doing this. You can also do this in Power Query, I've decided on a DAX
approach. When I press Enter, it returns a Table, which will essentially be a list of all of the dates
in that range.
Now at the moment, I'm on my Country Table. That does not look like dates. So I will click on
the Dates Table on the far right. And there we have it, starting from the first of Jan 2016, all the
way to the 31st of December 2019. And in the bottom right, it tells me that there are 1,461 rows
in this data. Now you can see it's brought back the date and also the time. So I'm going to select
that Column. And on the ribbon above, I'm going to specify that I only want the date Data type.
In this Model, we are not working with any time. So it's not important for us.
I could, if I wanted as well specify some formatting up here. So at the moment, it's got the first of
January 2016. I could use this dropdown and change the format. So maybe I'll switch it to a
classic DD MM YY format, as we use here in the UK. And there we have it. But regardless of
your formatting, we have that list of dates, and it is dynamic. In the next video, we're going to
start adding the additional Columns to this Dates Table that we may use in our analysis.
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Video: Additional Date Columns
Alan: In this lesson, we will create the additional Columns in our Dates Table that we may want
to use in our Report. Now, we're going to be using DAX here, creating Calculated Columns.
There are two main types of DAX formula, Calculated Columns, which we're using now, and
Measures, which we cover in the next module. So let's look at these Calculated Columns. We've
seen a DAX formula returning that list of dates that Table. And if I return back to the Home tab,
there is also a button for New Column. So if I click on that, now we need to use DAX, for our
Column, much the same way as the previous one.
Now, this first one will be for the year. So I'm going to call it Year = and nice and easy, it's going
to be the YEAR function. And I'm going to use the Date Column that we just created. Now, even
though the Date Column is right next to where we are right now, I'm going to reference the Date
Table, and then the Date Column. And that may sound a little bit strange, why I mentioned the
Dates Table, because we are in the Dates Table right now. Why does that benefit us? Why
should we bother?
Well, the way that the Date Field looks with the square brackets around it is exactly the same as
what a Measure looks like. And we'll see that in the next module. For the moment, just take my
word for that. So because they look the same, it's always encouraged to put the Table name
before the Column name. Because then, people looking at your DAX will know it's a Column
and not confuse it for a Measure. So it's (Dates[Date]), and that when I hit Enter, will return the
years from the Column next to it. Let's go for another new Column, we've got a few to add here.
Next Column is going to be for the month.
Now I'm going to call it MonthNumber, because that's what it's going to do. And we're going to
use the month function. Probably no surprise there. And it's Dates Table, Date Column, very
similar to before, so going through at a reasonable speed. And now we have the Month Numbers.
Now the next Column is going to be something a little bit different. Because this time, I want the
MonthName, such as January, April.
Now for this one, I'm going to use a function called FORMAT, which converts a Value to text in
a specified number format. And the Value is going to be the Dates Table Date Column again,
comma, but the format will be to show the word. So I'm going to open up some double quotes,
and put three M's in there. Now if I put four M's, it will be January and September. But when it
comes to the Report, I don't really need the full Month Name. And often we're trying to conserve
space. So, the three letters will suffice.
Just to demonstrate this, if I do put four M's in, close off those quotes, close bracket and enter,
then we will get the complete name. But if I select that Column, take out one of those M's and
press Enter, now we have the shorter name, and that's what I want. We could if we wanted create
two Columns, one with the short version and one with the long version. But that will do for now
it's new Column. So now we want the day. So I'm going to call it Day. And it's simply the DAY
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function. Based on that same Table we keep using, the same Column we keep using, so that's the
day of the month, like the first and second.
What we now want to do though, is find the day of the week. And we're going to find the number
first of all, so new Column. And we're going to call this one WeekdayNumber. And we're going
to use a function called WEEKDAY. Now the really good thing is that some of the functions
we've been using here, like YEAR, and MONTH, and now WEEKDAY, actually exist in Excel
as well. So for those of you who may have used these before, in your familiarity with Excel, then
that certainly helps you pick up that you already know some DAX functions. At the same time,
don't worry if you haven't used those, you're not a big Excel user. Because we're all learning
DAX at the same time here. So it's WEEKDAY.
Now the date, I think we know what that is. But then when I put in a comma, it will prompt me
for what numbering system I want to use. I would like to use a numbering system that begins
from Sunday, Sunday is one, and Saturday is seven, well, maybe. But if I move to the next one
down, that works with Monday being one and Sunday being seven, and that's what I would
prefer to use. So I'm going to select that. And that's the second option, so puts the index of two in
there, close bracket and press enter, brings us the weekday number. So the first of January 2016
was a Friday, because the fifth is a Friday. Okay, new Column.
Next up, we want the Weekday Name, just like we did with the month. So Friday, Saturday, and
I want the shortened version again. So let's call this one WeekdayName. And the formula will be
FORMAT on the Date Column. And the format is going to be three days. Don't forget to use
your double quotes around it. So just like we did with the month, that's going to bring back those
shortened versions of a Weekday Name.
Now for one final Column in here, because we could go on adding quarters and financial
quarters, and concatenating months and years. And lots of other stuff that you do sometimes see
people use. They may even have time dates put in here. For us though, I wanted my final
Calculated Column to be an IF function, a very popular function. And aside from what we've just
been writing, one of the more common uses of a Calculated Column. Calculated Columns are
nowhere near as commonly used as the Measures we see in the next module.
Normally, when somebody mentions DAX, they're talking about a Measure. But at the moment
we are building this Table out, so these are Calculated Columns. So one more Column. This one
is going to be whether it's a weekday or a weekend. So I want to use the IF function to test that if
the weekday number is greater than five, then it's a weekend. I'm using Saturday and Sunday as
my weekend Date, which is six and seven numerically. So the Columns going to be called
IsWeekend. And I'm just going to display a yes or no. So if function the logical test is if in the
Date Table, remember to reference the Table.
Let me move down here where our one Weekday Number is greater than five, comma, display
the word Yes. Comma display the word no, if it is not the result. If false, close off that bracket.
And pressing Enter, now we have our final Column is weekend where Saturdays and Sundays
have a Yes. And the Monday to Fridays have a No.
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And this is our Dates Table, which has got a few more things to iron out over the next few
lessons and we're good to go to write our Measures.
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Video: Sort Months and Weekdays
Alan: In this lesson, we need to solve a problem that we have with the way that our Month Name
and Weekday Name Fields have been sorted. Now, let me show you what I mean.
If I switch to Report view, and if I insert a Visual, such as a Table, and then over in the Fields
list, if I use the Month Name in the Values area, then you can see that they're not sorted in the
correct order. They are sorted in A to Z order. So April is first followed by August followed by
December. That's not the order month should be in. But Power BI doesn't know that. Software
such as Excel knows that because they have a built in custom list. Power BI does not have that.
But we will solve it.
Just to demonstrate if I remove the Month Name Column by clicking the X and I bring in the
Weekday Name Column instead, then we have the same issue. It starts from Friday followed by
Monday, followed by Saturday. So they're in A to Z order, and not in the order that Weekday
Names go. So let's switch back to Data View. And I'll begin by selecting the Month Name
Column, that sort that one first. And up on the ribbon, go to Column tools. In here, there's a
button called Sort by Column, and I can select from the list the Column to order it by. And this is
where we want MonthNumber.
I can say that those words should be ordered by those index numbers in Month Number. I can
now do the same to the Weekday Name. If I select Weekday Name, Sort by Column,
WeekdayNumber, and that's why I've used those numeric Fields. I could use them in a Report,
but I'm more likely going to use words just March or Sunday. But I've included those numbers in
the Dates Table to drive the order of those names.
Now if I switch back to Report view, I can see that those Weekday Names are in order. And if I
go and remove Weekday Name from that Visual and add in the Month Name, then they are also
in the correct order.
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Video: Mark as a Date Table
Alan: With our Date Table now set up and working, we need to tell Power BI to use it. And we
do that by marking it as a Date Table. I'm in the Report view at the moment. So if I click on Data
View on the left, make sure that I'm on the Dates Table, which I am.
And in the ribbon, the Table Tools tab, where we can see the button to mark as Data Table. If I
click on that button, and choose to mark this Table as the Date Table, a window will appear
prompting me for the Column that contains the dates.
So from that dropdown list provided, I will select the only Date Column in this Table, which is
Date. That is validated successfully, and now I can click Ok. And that is done.
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Video: Hide Fields from Report View
Alan: Now that we have our Model set up, in this lesson, we are going to hide some of the Table
Fields. At the moment, if we look over to the Fields pane on the right, and I expand some of the
Tables, such as Sales, and Products, they contain all of their Fields. But not all of these Fields are
going to be used in our Reporting.
A lot of those Fields are ID Fields that were necessary to create those Relationships, but I may
not be using them in my Visuals. So they can be hidden, just to declutter that Field list, and make
our lives a little bit easier, which I think everybody appreciates. Now, this is easiest done in the
Model view. So if I switch to Model view, so we can see all the Tables already expanded. And
we can also select Multiple Fields at the same time in here. So let's look through our Tables.
Starting with Country, we have the Country name and the Country code. I think both of those are
useful, and could be used in Reports. But then we have the Country code Field again, in
Location. And that's important because it's establishing the Relationship. But I don't need two
Country codes. I'm also not interested in the Location ID, the Location is sufficient here, the ID
was just an index that we created in an earlier lesson. So if I click on Country code, hold Control,
select Location ID, and I'm going to hide those from the Report view. So we're just doing some
final tidying up here.
We then have the Products Table, Category Product, and the ID. Once again, I don't need that
ID, let's hide that from Report View. And you can see, they have this little icon of an eye crossed
out to indicate that they're hidden. Then we have our Sales Table here. Now a lot of that
information can go. I don't need the Date, or the Location ID, or a Product ID. Indeed, I don't
even need the Amount. So I'm going to select each of those Fields, I'm going to keep the Order
ID, there's a possibility that an order ID could be used within some kind of Visual. But the rest of
them I'm going to hide.
We don't need the Amounts Field. Because in the next module, we're going to create some
Measures with all of our calculations. And I'll still be able to reference the Amount Field, it just
won't appear on the right to be used within any Tables or any Charts. You can always come back
here at any time and unhide these Fields if it's a mistake at this point. Now something else we
may notice being in here is that our Dates Table is not connected to any of the other Tables.
So let me drag it into play a little bit more. And I'm going to click and drag from the Date Field
in Sales, up to the Date Field in Dates, to create that Relationship between the two Tables.
Remember, you can hover your mouse over the Relationship line, just clarifying that the two
Date Fields have been used. Within the Date Table, I'm going to hide the Weekday Number and
the Month Number Fields.
They were important, they enabled us to sort the Month Name Weekday Names in an earlier
lessons, but I have no plans to use them in any kind of Visual. So, our Relationships are set up,
we’ve decluttered it by hiding certain Fields. So if I was to switch over to the Reports view,
which is where we generally spend our time when we're creating our Reports. And over in the
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Field list on the right, if I was to expand the Sales Table, there is only one Field in there; Order
ID. And if I expanded the Dates Table, there is no Weekday Number or Month Number.
So we can still see them in other views like the Model view, but we can't see them in a Report
view, just giving us a cleaner working area.
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Video: Practice Exercise
Alan: Hello and welcome to the practice exercise for the data Modeling module. Go ahead and
open file 3-7-practice-exercise and follow the instructions provided.
There is a completed version of this Power BI file named 3-7-seven-practice-exercise-complete
for you to check your work against. Have fun.
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Section 4 – Total Revenue
Video: Total Revenue
Alan: In this lesson, we are going to write our first DAX Measure. Now we have written some
DAX, so far in this course, to create that Dates Table, and the different Columns that we want to
use. But now we're going to create a Measure, not a Calculated Column. So this is an aggregated
value.
And for our first example, we are going to simply sum the Amount Column from the Sales
Table. Let's just quickly have a look at this. If I click on the Data view, and come over to the
Sales Table, there is the Amount Column for each order, and we want a total of that. Now
coming back to the Report View for a moment, I did use that Amount field in this first Visual,
this Table where it's breaking down that total by Category. So you might be wondering why I
would create a Measure, when I've demonstrated that I can achieve results without it simply by
dragging the amount field in.
And there's a few reasons for that, by creating a Measure, I have that single calculation, which I
can then use multiple times. But it is only one calculation. Whilst when I move the Amount field
into that Table, and potentially a chart or two or another calculation, then I've got multiple
different calculations on the Amount field going on. What it also means is that I can provide
formatting in advance. So you can see in the Table that the Beverage value only has one decimal
place. It’s the biggest value out of the three, but it doesn't look like it because of that deceiving
missing decimal. Now I could format that Column. But, I would have to do that every time I use
the Amount field. So Measures have their advantages. Let's look at creating one.
I'm going to begin by clicking on the Sales Table on the far right, so that the Measure is created
inside that Table. Then, up on the ribbon, we want a New Measure button. Now I can see one
now under the Table Tools Tab. But that New Measure button is found in quite a few different
taps. If I clicked back on the Home Tab, it's in here as well. If I click on New Measure, that will
open the Formula bar, just like before. And remember, I can hold down the Control key and
scroll my mouse wheel up to zoom in on that Formula bar and make things a little bit clearer.
Now the name of this Measure will be Total Revenue = and probably no surprise here that I'm
going to use a Sum function. Just like in Excel, DAX also has a sum function. So if I double
click on Sum here, that will prompt us for the Column name. And that is the Sales Table Amount
field. So even though I've hidden the Amount field, and we cannot see it in the Field list, on the
far right-hand side, it is available for use in our calculations. If I choose the Amount field, close
of that bracket, and press Enter, that is that Measure created.
Now before I go any further up on the ribbon above, we are now on a Tab called Measure tools.
And I have the opportunity to provide some formatting. I can see it is already in a Currency
format. But if I want it to be more specific, I have this little currency symbol button. And I could
switch this to Pound Sterling or into Euros or any specific currency symbol that I'm interested in.
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I'll put this into my Pound Sterling. And then we also have the option for wherever we want to
show decimal places or not. And I'll keep this as two decimal places. Now I selected the Sales
Table before I created the Measure. So we can see on the right-hand side that it has been created
within that Table.
However, looking back up to the ribbon, if I had made a mistake there, there's a nice dropdown
list where I can choose what Table that this Measure should reside in. So I could use that
dropdown to move the Measure if I've made a mistake and inserted it into the wrong Table. So
with that done, let's test this out. If I click on my Report to clear the Formula bar, and then if I
click on that first Visual, that Table, and over in the Visualizations Pane, I'm going to remove the
Amount field from the values area and replace it with my Total Revenue Measure.
You can see that Measures have a Calculator icon to identify them. And if I drag that into that
values area, I get the exact same result as before, although you can see Beverages does have two
decimal places, sort of formatting is done in advance. I can even come and select the next Table
down where I have Month names. And I could go and drag my Total Revenue Measure into there
as well. And now we can see the overall totals by month. This is for all of the years at the
moment because I don't have any year filter being applied. But it does demonstrate that our
relationships are working.
As I'm using Data from the Sales Table, the Dates Table, and the Products Table at the moment
in these two Visuals, but also I’ve used that same Measure twice. However, it is only one
calculation.
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Video: COUNTROWS
Alan: The second Measure we are going to create will be to find the total Number of Orders that
we received. And for this, we will use a function called COUNTROWS to count all of the rows
within our Table. And that Table is going to be the Sales fact Table.
Now my Sales Table is currently selected. So from the Home tab, if I click New Measure, and
the name of the Measure will be Number of Orders, let me zoom in on that Measure, we will use
the COUNTROWS function. And that function will simply prompt us for the Table name, which
is Sales. And as simple as that, close bracket and press Enter to run that Measure.
Directly above the Formula bar, I will provide the formatting is a whole number already, which
is correct. But I will click on the 1000 separator, comma and that Measure is created. To see it in
action, if I select this monthly Visual, and over on the right-hand side, I'm going to drag the
Number of Orders Measure into the values area. And let's just expand the size of that Visual so
that we can easily now see the Number of Orders in there in addition to Total Revenue.
It's always a good idea to test your Measures out directly after creating them by throwing them
into some kind of Visual like that.
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Video: CALCULATE
Alan: Now for our next Measure, we are going to see a function called CALCULATE. And this
is possibly the best and most useful function in all of DAX. We want to use it here to total the
revenue for the weekend Sales, and also another Measure to Total Revenue for Sales, not at the
weekend.
Now the Calculate function can do a lot more than what we're going to go into in this course. It's
extremely powerful with its ability to remove or change filter context. All we want to use it for
here, though, is to create a conditional sum, kind of like a Sum If function in Excel, for those of
you familiar with that. So let me just check on the Sales Table to begin with, I click on Sales on
the right-hand side. And then I'm on the Table Tools tab. But there's a New Measure button there
so I'm going to give that a click.
The Measure name will be TotalRevWeekend. And I'm going to use the Calculate function;
evaluates an expression, which will be our Total Revenue, modified by it filters. So getting a
little bit more technical here, especially with the explanation there. But don't let that put you off,
if you're not so experienced with formulas, because the expression will be our Total Revenue
Measure. Now a really cool thing about this example, is because we are using a Measure inside a
Measure, and you can see the Calculator icon next to the Measure name.
And this is yet another advantage of DAX and the use of Measures over those implicit Measures
I mentioned a few lessons ago is that once we have written it that one time, and it's one
calculation, and we can format it in advance. But the fact that we can reuse it in other Measures,
so I don't have to write a calculation to sum the revenue. I've already done that, I can just reuse it.
So here we go.
Total Revenue, the comma, and then the filter is going to be if that Column that we created in the
Date Table earlier. So Dates, where is that Column is weekend as what it was called. Is that =
“Yes”. And we need that yes, in those double quotes. I can enclose off my Calculate function and
press Enter. And that's going to Total Revenue, use that Measure. But only if it is weekend says
yes, I will now check the formatting. So it will be the British pounds, and two decimals,
fantastic. And I'm going to click on this New Measure button. I've mentioned it's in a lot of
places, it's now on the Measure Tools tab. But if it says New Measure, that's what we want. And
this one is going to be the TotalRevNotWeekend, you may be able to think of more creative
Measure names than me.
But this once again, will be Calculate. I could have copied the previous one. But it's nice,
especially when you're learning to get some practice writing these out. So the Total Revenue
Measure, comma to move on to that second argument, the first of potentially multiple filter
arguments. We've only got the one, which is if in the Dates Table, the is weekend field is equal
to the value of No. Let's close that off and run it. And we've now got that second Measure using
Calculate. So always a good practice to test these out what I'm sure that's fine. But for this
example, let me bring in a Card, which I don't think we've done on this course so far.
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Over in Visualizations, if I click on the Card icon, which is that little one, two, three rectangle,
that's going to insert it somewhere on my page. Let’s put it all the way down here. That's fine,
but I prefer it up here. And I'll go and click one of those New Measures. Let's go for the Non
Weekend to begin with. So I don't really know what numbers I'm expecting here. But hopefully
with your own work you'll have a rough idea whether a three million sounds about right or not.
And it does here actually, I think we've got a little over, there you go, you got 4.3 million, that's
recorded as total.
So for five days in a week to bring three sounds about right. What will cement that is if I click
somewhere on my page to deselect that Visual, and I go and put another card in, and let's drag
that up. And for this one, I'll bring in the other Measure, TotalRevWeekend, and 1.22. So those
figures are shown as millions sort of been rounded to an extent. But those Measures are working
wonderfully.
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Video: SAMEPERIODLASTYEAR
Alan: For this next Measure, we want to find the Total Revenue of the previous year. Ultimately,
when we start creating our Reports, and putting our Visuals on, I would like a Report page for a
year versus the previous year. And that's why I’m creating this Measure ready for that. So it will
make more sense as the course evolves.
Now, there's also a few different DAX functions and techniques that you can use to find that
information. For this example, I want to use a function called SAMEPERIODLASTYEAR. So
I'm going to select my Sales Table and click New Measure. The name will be TotalRevPrevYear.
And we're going to use our new DAX friend of Calculate, something that can apply filter
context.
Now, the expression once again, is Total Revenue. So all about this revenue. But the filter
context, this time, is coming from a function called a SAMEPERIODLASTYEAR, that's going
to prompt for the Dates, just wants to know where your Dates are, and it can work out the rest for
you. And this is why it's so useful to have a Dates Table so that these time intelligence functions
know how to work. Now there is the Date Column in the Dates Table, I'll provide that, close
bracket for SAMEPERIODLASTYEAR, close bracket for Calculate. And if I run that Measure,
it's now added into our Sales Table.
Now this type of Measure can be a little bit harder to test. But what we'll do is if I click on this
Visual, this Table with the months and a Total Revenue, Number of Orders, and over on the
values area, I'm going to remove the month name, and I want to replace that if I expand the Dates
Table with a year, I bring year in there. Now it sees the year as a number, so it's defaulted to
Count of the year. I'm going to click this little arrow and change that to Don't summarize. So
now we get those years in the Table. And I can see the Total Revenue over those years.
Now, whatever the Number of Orders at the moment, let me remove Number of Orders and bring
our New Measure in instead, which is this one here; TotalRevPrevYear. Let me drag that in
there. And hopefully this now shows the results. So for example, if we look at 2018, the Total
Revenue in 2018 was 1.3 million, previous year was 809,000. And if you look at 2017, which is
obviously the previous year to 2018, there is that same number. And this is a nice way to check
that oh that is working. It is returning the right total for the previous year. Excellent. Now we
have that peace of mind knowing that it works, we'll be able to use it later in one of our Reports.
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Video: Year Difference
Alan: For our last two Measures, we are going to calculate the difference, and the percentage
difference between a year and its previous year, working with two of the Measures that we have
already created.
So with the Sales Table selected, up, we come to New Measure. This first one will just be a real
simple, what's the difference, we're going to name it TotalRevYearDiff. And it's going to be the
Total Revenue Measure and subtract the other one we did. Notice how I'm calling them all Total
Rev something, you can call these, whatever you like. You can also use spaces in their name, I
just have a habit not to use spaces. But the fact that I have used a consistency with the words
Total Rev, or Total Revenue means that as I type it out, all of my options come up. Makes it
easier if I'm not 100% sure what I named it. But if I know they're in this group, I can find it. Now
the one I want is TotalRevPrevYear.
Now, this might look a bit strange, the fact I'm doing a Total Revenue, takeaway one for last
year. But bear in mind that there will be some context. So without using a Measure for Total
Revenue, and you might think of that as the 4.3 million, it's not. Because when it gets used inside
a Visual, there will be some filter context applied. In this example, I will apply a year's filter
context, just like there is in that Table one screen at the moment, where the year is filtering out
that Total Revenue.
So this can be a bit awkward sometimes to get your head around when you're new to DAX, using
a Measure like Total Revenue, where you might think that you'll need some kind of current year
Measure, but you don't. That will be the current year when it's applied. Okay, anyway, it's
TotalRevPrevYear, when I press Enter, that Measure is created. And I'll just apply the formatting
of Pound Sterling to decimals. And let's click New Measure to now find a percentage difference.
So I'm going to name it the %TotalRevYearDiff.
And for this, we are going to use a function called DIVIDE, I could just divide two numbers with
a normal division calculation. But in DAX, there’s a function called DIVIDE known as the Safe
Divide function, because it offers an action to perform if divided by zero. Now, that's kind of
unnecessary for our example, because I know there are values. But using this as best practice, the
numerator is going to be the previous Measure, which was Total Rev something,
TotalRevYearDiff, that's what it was, comma, the denominator will be the previous year value.
So that's TotalRevPrevYear.
And then we've got the opportunity for that alternate result. And I'm going to stick a zero in
there, close off the bracket, but it's simply going to divide the difference by the previous year
value, so that when I press Enter, we now have that Measure. And in the formatting above, I
would like to apply a percentage to it, and I think I'll keep the two decimal places. Now to see
these in action, I'm going to throw them into this Table Visual. So if I click the Table, and over
on the right-hand side, let me just widen this filter pane so I can read what they're called.
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I want TotalRevYearDiff, and percentage; get in now. And now if I widen this Table, there we
have it. Obviously for 2016, it will look a little bit odd because there is no previous year. You
can see the alternate result working and my divide function. Because there was no previous result
it just displays zero, which is what I asked it to do. And then it begins to make sense. You can
see for 2017, a 79,000 increase in revenue, which works out at nearly 11%.
Then a huge 2018 improvement and a much smaller, but still improvement for 2019. So those
Measures all working brilliantly. It's now time to start looking at the array of Visualizations we
can use, and start building our Reports with them.
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Video: Practice Exercise
Alan: Hello and welcome to the practice exercise for the introduction to DAX Measures module.
Go ahead and open the 4-6-practice-exercise Power BI file, and follow the instructions provided.
On the instructions page.
There is a completed version of this file named for 4-6-practice-exercise-complete for you to
check your Measures against. Have fun.
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Section 5 – Card
Video: Card
Alan: It is now time to start adding some Visualizations to our Report pages. And there are an
abundance of Visualizations available. So, over the coming lessons, we are going to look at the
more useful ones. And we are going to begin here with the Card. Let me begin by naming this
page. So at the bottom, we have a Page tab, just like sheets of Excel. And if I double click on that
page, I can name this Summary. And this is going to be our main Report, an overview of the
business. And let's go and add our first Card.
So remember, the Card is that little 1, 2, 3 rectangle icon. And if I give it a click, that's going to
dump that Card, a tile onto our Report page. I have this Field open up below. And I need to drag
something in there. And I'm going to move Total Revenue into that. I can tick the box or drag it
into that Field area. Or, I could drag it directly onto the tile, onto the Card. Now that shows 4.27
million in Total Revenue. I now want to do some formatting to it. And just above the Fields area
where I dropped the Total Revenue, there is a little button with a paint roller. And if I click on
that, for all of our Visualizations, this is where you get to the formatting.
Now the options you get are going to differ between Visualizations. And fortunately, so does
some of the naming. So it's not always that clear what each element of a Visualization is. For
example, in this Card, I can see it says Total Revenue underneath the Value. Now that is the
Category. So you can see looking back at the formatting, that the Category is on and the Title is
off. Whereas you may have thought that was the Title. Now I'm actually going to turn off the
Category, because I don't want the Measure Name where I have not used spaces. And I'm going
to turn on the Title, which actually appears above the Value. And now I'm going to expand that
Category so that I can type in the text.
I'm going to put Total Revenue with a space. And I'm also going to center align that Title. And
I'm going to increase the Font size to 16. Now let me collapse that Category so that it’s cleaner to
work through some of the others. And let's look at the Data label Category. So this is the Value,
the 4.27 million. Now the first thing I want to do is make the Font a little bit smaller, 45 is quite
large. And I'm going to have other things going on here. So you can either use the spin box
arrows and move down like I am. Or, I could just click inside and type what I want, such as 30.
Now the display units, they are showing as millions. It says auto there, but that is millions. And
if we click on the dropdown arrow, I have the opportunity to change the units. And I'm going to
set it to None. So as I do that, now I can see the full Value in that Card. For decimal places, I'm
going to set that to zero, I don't want to see those. I’m now going to collapse the Data label
group. And what else should we do?
Let's add a Background, there already is a Background is on. But it's a white background. And
I'm going to change that for many of these Visuals to a light gray. And then I'm going to come
down to Border, let's add a Border to this to really make it stand out. I’m going to put a 3 pixel
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Border on it, there we go. So if I click back onto my Report page, this is my Card. I now just
want to resize it and move it into position as we slowly build up these Reports. I now want a
second Card with the same look and feel. And this one will be for the Number of Orders.
Now what's very important here is that I have automatically clicked somewhere on the page, a
good habit to have. Because if you have a Visualization selected, when you go and click on
another Visualization, it will affect the one that's selected. I want to click away from that on the
page, then come over and get another Card. This Card is going to be for Number of Orders. And
then I want it to be formatted the same. So I'm going to click on my Total Revenue Card. And
then up on the Home tab, click the Format Painter button, and then click on the Number of
Orders Card, and it adopts the same formatting. That is such a useful button.
However, at the moment, it’s not the same size. It also doesn't have a Title. So coming over to
the Formatting area. Let's look at the Title and put in Number of Orders. Then I'm going to click
on the Total Revenue Card so that I can come into the general Category and see that the width
and the height is 280 and 118. So now, click on my Number of Orders. And in the general
Category 280, 118 is now the same size. And I'm going to drag it to the right of the other Card.
So as I click away, here we go. We have our two Cards, one for Total Revenue, and one for
Number of Orders.
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Video: Column Chart
Alan: In this lesson, we are going to add a Column Chart to our Report. So coming up to the
Visualizations area, you can see that there are a few different types of Columns and Bar Charts .
Now the one I would like to add is the Clustered Column , which is the fourth one in the list.
The first two are Stacked Bar and Column Charts. So if you put a Value into a Legend, it will
show the contribution to that total. The next two though are the Clustered Bar and Column,
which is what I want. And I would prefer the Column over the Bar in this example. The two after
that are the Percentage Stacked Bar Charts. So similar to the first two, but we'll stack to 100%,
rather than the total Value.
So I'm going to click on this fourth one, the Clustered Column, that will put it somewhere on my
Report. And I think I'll begin by dragging that underneath the Cards, which is ultimately where it
will go. Isn't it brilliant that we have these alignment guides appearing in red dashed lines?
Makes you so easy to drag, resize, and align these different Visualizations to each other. So I've
made it equal in width to the two Cards, and now I need to get it to do something. So coming
over to the Visualizations pane, we have four different Fields: Axis, Legend, Value, and
Tooltips.
Well, the Value, that's going to be the Total Revenue, so I'll drag Total Revenue into Value. And
immediately that will show the Total Revenue 4.272 million as a Column. Now we need
something in the Axis. And we've got quite a lot of things that we could pick from. For example,
I could put the years in there. If I drag the year into the Axis, I can see the Total Revenue for
each of the years from our Sales Data. Now, we also have this Legend area.
So in the Legend, I could expand Products, and maybe put Category into the Legend. And that
will show me how each Category has performed over those four years. So I can see that Food
was bestselling in 2016, but was overtaken by Beverages in 2017. And then it pretty much tied at
the last two-years. Ultimately, we are going to use a Slicer on this Report so that people can
manipulate the Date range. So I'm going to come back and remove the year from this Chart, I
don't want it to be here.
And I'm going to move Category into the Axis, as I'd still like to see the Revenue of all of my
categories. Now the one other Field available to us there is Tooltips. And what that is, is if I
position my mouse over one of these Columns, such as Food, this little Tooltip comes up and
tells me the Category is Food, and then the specific Value, which is pretty cool, because I can't
see the exact Value on that Axis on the left.
But by using that Field, we can add information to this. So we could go in add the Number of
Orders Measure into the Tooltips. So that when I position my mouse over a Column, like Food
again, I can also see the Number of Orders. Even though it's not a Value plotted on the Chart, I
can show this information into the Tooltip. So that's a pretty cool option, and a lot of our
Visualizations come with the option of a Tooltip. Not all of them, but a lot of the Charts do. To
finish this Chart off, I want to do some formatting.
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So let me click on the Formatting option, and look at all of these. Now first of all, I've got a
couple of warnings on the Axis. Now obviously that Chart is absolutely okay. But if I position
my mouse over these errors, they are warning me about the font having to be reduced. And that I
should enlarge the Visual. So, let me do that. But come back over, I'm going to make this Visual
a little bit larger in height, I don't really want to change its width though, because I'm happy with
it being aligned with those Cards. And now looking back to the Formatting area, I can see the
errors have disappeared, and they're happy that I've been able to increase the size of the font. So
very interesting that they show those errors to us.
Now, we've got lots of other Chart options here. And we're not going to explore all of them. But
something I would like to do is turn the Data labels on, I think that's great. Now I can see much
better guide to those Values. It's still rounded heavily, but I've got a much better idea than I did
by looking at the Axis. And talking about the Axis, I'm going to turn off that Y Axis, as that label
has now replaced it. Now looking at the Chart, I have labels for the two Axis, Total Revenue,
and Category. Because of that, I don't think I really need the Title above. So I'm going to switch
off the Title in this Formatting area as I think that's too much noise.
I've already got the Y Axis label of Total Revenue, I don't need it mentioned at the top as well.
Two final formatting changes, I'm going to change the Background to the same light gray color
as the Cards. And I'm going to put a Border around it of 3 pixels, keeping some consistency to
the look of my Report. Now that is just a quick example of some of the options that you get with
just one type of Column Chart. So as we go through these lessons of these useful Visualizations,
really it is upon you to explore some of the shade gulf of settings that you get in Power BI.
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Video: Map
Alan: The next Visualization for this Report is going to be a Map. So that we can plot the
Revenue over the different Locations that we have our shops. Now in the Visualizations pane,
there's actually quite a few different types of Maps available.
There is one on the bottom row here. But then as I scroll up, we also have these Shape Maps,
which is one of the newer Visuals, and doesn't work for all of the countries at the moment. But
it's growing, and they're pretty cool. We also have this Field Map. And then we have the one that
I want to demo right now, which is simply called Map. But there's a few for you guys to check
out in your own time, we don't really want to dedicate hours to using different Visuals, and also
formatting them.
So if I click on this Map Visual, and then drag it into Location, which is going to be on the righthand side. And I'll try and resize this, so that it fits neatly by our Column Charts and our Cards.
Okay. Now it needs some Data, let me click on that Visualization, and there are six different
Fields available. Some of them we have spoken about with the Column Chart, such as Tooltips,
and Legend. Location is one that pretty much speaks for itself. And I want to put the country in
there.
So if I expand the country Table, and I'll drag the name of the country into Location, and I'll see
the Map, try and work that out, and successfully plots all the different countries. At the moment,
though, I don't have anything in the Size Field. That's where our Measure will be, that's Total
Revenue. So if I drag Total Revenue into Size, now the size of those bubbles, those circles will
be dependent on the Revenue. Really cool. Now you can see the US and Australia pretty clearly.
But it gets to Europe, it's much harder to see because of the cluster of countries that you get in
Europe, and the shops that we have there.
But what's really good with this Map is if I position my mouse over the Map, and near Europe,
and I scroll up with my mouse wheel, it zooms in on the Map. So now I can clearly identify and
even drag to get Europe more central and see the likes of Sweden too, and clearly make out
which circle belongs to who. And we can see that the larger bubbles are larger circles, belong to
the UK, Germany, France. And so healthy contributions from Denmark and Poland also. I can
easily scroll back down to zoom out if I wanted to access any other parts of the world. Now we
do have the Tooltips filled as well.
So if we wanted, I could add more information to that, such as Number of Orders, just like with
the Column Chart. And when I hover over one of those bubbles like the US, I can see the
Number of Orders in addition to the Total Revenue, which is displayed because it's in the Size
Field. Now I'm happy with that, I just want to do some formatting changes now. So if I click on
the paint roller, and I'm going to remove that Title along the top. I know this is the Total
Revenue being displayed so I'm going to remove that. Obviously those Titles are helpful if it's
not clear what this Value represents, though.
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But unless stated, everything on this page is Revenue. I'm also going to change the style. So if I
open up this Map styles, I currently have the Road Style. I'm going to change that to the Light
Style because I think that works quite nicely with the rest of the color scheme on this Report. I
can even come and change things like the colors of the bubbles and plenty more options to
explore. But for now, that is done. We have our Map on our Report.
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Video: Slicers
Alan: In this lesson, we are going to look at the Slicer Visualization. Slicers are brilliant,
because they allow us to filter the Visualizations on our Report. Now in a later module, we are
going to look at other Filter and Interaction options available in Power BI. Because one of its
great strengths is how rich it is in these interactive elements, but Slicers are definitely one of the
better options.
So on this Report over in the Visualizations pane, the Slicer is this little Card with the filter on.
And in this Slicer, let's drag the Date into that Field area. And here we have it. Now because I've
moved a Date Field into it, it has automatically adjusted to this timeline. Let me just come and
move this Slicer over to where I'm ultimately hoping to have it. Okay, so this is better. So with
this Date timeline, I can click and drag the ends of it. And as I do, so, you can see all of my
Visualizations are adjusting, especially the ones in the left. You don't see much movement from
the Map, but that is being interacted with as well.
I can also click into these Date Fields, and choose from this little calendar picker. So we could
have the 1st March 2019. And then come into here and choose the 1st March 2017. And grab that
two-year range. So this is a terrific use of a Slicer. There is a small eraser button in the top right
to clear what's in the Slicer. And next to that eraser, there's also a small arrow. And this provides
other options for how you use the Slicer. So at the moment, we have it on Between. So I could
drag the ends of that timeline in and get the results between two Dates. But we also have this
option Before. And now I only get the end.
So I can look at all of the results before a specific Date. And if I choose the one saying After, I
think we know what this is going to do, I can now get older results after a specific Date. I'm
going to change this one back to Between. Now it's time to create our second Report page. So
coming down to the Page tab at the bottom, right-mouse click on that page and duplicate page.
So I have a copy of that Report. And I'm going to name this Report page Yearly Variance,
because that is ultimately what it's going to do for us. But on this Report page at the moment, I
just want to change that Slicer to a year.
So if I click on the Slicer, and over on the right-hand side, remove Date from the Field and
replace it with Year. And it keeps this Between timeline, which we might be happy with. I could
drag that into 2018 or enter a year in the box provided, it’s very useful. But remember, we have
this little arrow in the top right corner. And I'd like to explore the options for List and Dropdown.
Notice before we do that, how the options in this list have changed.
We're getting different options for Year, than we did for the Date. It's very clever. There are so
many options with this stuff. I know I've said it already in this course. But it's something that you
really need to explore and get your teeth into. And far too many options to cover them all on this
course.
But let's look at the List and the Dropdown. If I choose List, I have all four years of that Data.
And remember that may change over time. You may have more than four or less than four. And I
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can just check the box to get 2017, or check the box to get 2019. So I think that worked quite
nicely, because we only have four years. So having them in a nice list like that works pretty well.
I can hold down the Control key on the keyboard, and select other years at the same time.
So I can view the last two-years as it would be 2018 and 2019 there. And I can see the two Cards
working, and the Column Chart as well show my Category performance. And also not to forget
our Map, although you don't really see the Visuals moving too much. If I hover over a bubble,
that is the Value for 2018 2019. Now keeping it on the List for a moment, and coming over to the
Formatting options for the Slicer, we haven't looked at any of these Formatting options yet. So
we have an option for the Slicer header, which we could choose to remove. Do we really need to
be told that's a year? Probably not. But I think I'll keep it there.
I have the opportunity to add a Background, like a dead to my Cards and my Column Chart. But
what I'm really interested in here are the Selection controls, 3 useful Selection controls here. And
you can see Multi Select with control is switched on. And that's what I did to get 2018 2019. If I
was to switch that off, then the Slicer would change. So that all I have to do is click to get the
years that I want. I don't have to hold down the Control key anymore. So that's pretty cool. If you
want somebody to easily perform Multiple Selections.
What I could also do instead though, is switch on Single Select. And now the Slicer will only
allow somebody to select one year. So depending on what Slicer you're using, and why you can
change how the recipient of this Report interacts with it. Now I like the Single Select here,
because I want people to only choose one year. But coming back to the Slicer, I don't want this
List anymore. I'm going to change it to a Dropdown. And now people can choose the year from a
simple Dropdown list as opposed to a static list that you always see.
I can now actually make this Slicer a little bit smaller, as we don't have too many Visuals going
on here. But if you've got a busier Report, saving some space with a Dropdown versus a List
could make a world of difference.
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Video: KPI
Alan: In this lesson, we are going to look at the KPI Visual. And this Report page is all about
comparing the year that is selected in our Slicer against the previous year. Now we wrote some
DAX in an earlier module, calculating the difference, and the percentage difference, and also the
total to that previous year. And we're going to use them now in our KPI Visual. Now, I want this
KPI to be used instead of the Total Revenue Card. Because it looks very similar to a Card,
although you can set a goal and compare against it. And the goal will be the previous year's total.
So let's have a look at this.
I'll begin by removing the Total Revenue Card. If I click on that Card, and then simply press my
Delete key on the keyboard, it's gone. And over in the Visualizations pane, I will click on the
KPI, which is the button with the green and red triangles. If I give that a click, in it comes and
our first job is to do some rough resizing, and some perfect aligning. So I can easily align it with
the Visual underneath and also to its right. And now let's get it functioning. So over to the
Visualizations pane, we need to bring in those DAX calculations into the 3 Fields provided.
If I expand the Sales Table, where all of our DAX Measures are contained, and the indicator is
the Total Revenue. In it goes, widen this Fields pane, the trend Axis is going to be the year. So in
the Dates Table if I bring in the Year Field. Because I'm comparing this year to last year, that is
the trend. Immediately, you can see the KPI bringing back some information, showing the Total
Revenue for the current year, which is 2019 selected in Slicer. But now, in the Visualizations
pane, the last Field is the target goal. And the goal is the previous year's Total Revenue, we have
a Measure for that called TotalRevPrevYear. So in that goes, and that is your KPI.
We're going to improve its appearance a little bit, but I can see the Total Revenue showing in
green with a tick as well, because we met our goal. Then underneath it, we have the goal, which
was 1.34 million for the previous year, and tells us that it was a 4.54% increase on that previous
year. But if I was to change the Slicer from 2019 to 2018, we can see that that was a huge
improvement on the previous year. But if I was to change it to 2017, that was a smaller
improvement.
And in 2016, there's no point because there is no previous year to 2016. I'm going to bring that
back to 2019. And let's look at making some formatting changes to that KPI. I want to start by
making it the same width as the Card to its right Number of Orders. We can also make Number
of Orders a KPI. But in this course, I haven't created Measures to calculate the previous year's
orders. So maybe that's something you can do as some practice. Now that Card for Number of
Orders is 280 in width.
So with my KPI Visual selected, if I click on the Formatting button in that Visualizations pane,
and I'll move down to the general Category, I can see the width is very close. But 280 is the real
width. And now I know it is the same width as the Card to its right. Let's make it looks a bit
more like the same. So if I collapse the general Category, and let's switch the Border on, and I'll
make that Border 3 points just like the others or 3 pixels, sorry. Collapse the Border and
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Background is going to be that same light gray. And then I want to make some improvements to
the goal and the indicator and also that Title, all 3 bits of text.
Now the first one in the list is Indicator. So let's start with that. It's 45 points in size, I want that
to be 30. That is the same point size as the Value in the Card Visual Number of Orders as well.
And I want that consistency, says 30 points. If I wanted to, I could also change the display units
here from Auto to None, just like I did with the Card in an earlier lesson. But I quite like the
millions being shown here. Because with the text for the goal, and the variance included, as well
there’s a bit more going on, than there is with a simple Card.
So I quite like the millions in that example. I'm just going to collapse the Indicator section and
open up the Goals section. So the goal is to text underneath the green indicator. So first of all,
you could turn it off, you don't have to have that goal. You could just have the text shown in
green, so that you know you met that goal. But you don't necessarily know how well. I do want it
there, I'm quite happy with the label saying Goal. But the text size, I'm going to increase to 16,
want that a little bit larger.
And then if I collapse the goals Category, next up is the Title. I’m going to expand that and begin
by typing a better Title. I just want Total Revenue. I don't need all that extra waffle in there. Let's
remove that. And I will center align the Title as well. And also make the text size 16 which is the
same size as the Title in the Number of Orders Card.
So that is the KPI Visual, a really useful Visual for comparing a Measure, Total Revenue, in this
case, against a goal. And it works very nicely on this Yearly Variance Report page that we're
building.
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Video: Line Chart
Alan: The next Visualization we are going to look at is a Line Graph. And I want to use that in
this Yearly Variance Report page instead of the Map Visual that we have.
So if I begin by clicking on the Map, and removing it by pressing Delete, and then over in the
Visualizations pane, I'm going to insert a Line Graph. And we have one here as the first
Visualization on the second row. If I click that, and as usual, drag that tile into position, and do
some resizing so that it's neatly aligned with some of that other Visuals. Don't need it that large,
let's make it the same size as the Chart to its left. Now remember, this Reports page focuses on a
one specific year, which is selected from the Slicer at the top of the page.
So I would like this Line Graph to have the MonthNames in the Axis. So we can see the Revenue
trend for that year. So over in the Dates Table, I'm going to drag the MonthName into the Axis.
And then we need something to Chart. So I'm going to bring Total Revenue into the Values
section. So we can see the Total Revenue Measure filtered by the year in the Slicer, and then by
the months in the Axis of the Line Graph. So here we have our Chart doing a nice job. Let's now
do some formatting improvements. If I click the Formatting button, and then just like the
Column Charts on this page, I'm going to remove the Title.
So in the Title Category, I'll simply turn that off, I'll make the usual changes for the Background.
And then also for the Border, switch that on. And then for something specific to this Line Graph,
I want to go into the Shapes Category. Because in here, we can tweak some of the options for the
line itself. For example, the stroke width. If I increase that to 5, I have a thicker line in the graph,
we also have a Join type.
At the moment, we have a Rounded Join type. But if we watch the Line Graph, and I changed it
to a Miter, you see we get a sharper Join on each month. Now I'm going to change that back to a
Rounded Join type. We also have the options for a Line Style. So if I change the style to a dashed
style, or potentially to a dotted style. But I do want the solid one, we have the chance to show
markers on here, currently set to off, and I'm going to keep it that way. And we also have the
option for whether we want it to be Stepped. And if I switch then on. So these can be used to
even more clearly define the change in the Value from one month to the next. Going from July to
August is a good example of that. So that's quite a cool technique.
But I'm going to switch the Stepped to off for now and have this classic line. But as with all of
these Visualizations, there's an abundance of settings. And like I have just done with this Shapes
Category, it's nice to walk through them and get familiar with what's available to you. Now the
last thing I want to add to this Line Chart is some Tooltips. So I'm coming out of the Formatting
and back into the Fields area, because I have the Total Revenue here over the year.
But I would like to drag our 3 Measures that show the Revenue and also compare the Revenue to
the previous year as a Tooltip. So let's drag in TotalRevPrevYear into this Tooltips Field. Also
the TotalRevYearDiff and also the %TotalRevYearDiff. So that at any point, if I position my
mouse over one of the lines I could not only see the Total Revenue, which has been used as the
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plotted Value, but also in the Tooltip, I can additionally see that for June, it was a 4.19%
improvement on the June from the previous year.
But if I look at this very well performing August, I can see that there was also actually even
better improvement 4.38% on August of 2018. So thought it's brilliant for adding this additional
information to a Visualization. It doesn't clutter the Visual because if I move my mouse out of
the way, I can quite happily view the Line Graph doing its usual job, plotting the trend over the
selected year. But it's quickly available if the user wanted to dip in to a little bit more information
behind the scenes.
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Video: Matrix
Alan: In this lesson, we are going to look at the Matrix Visualization. This is a brilliant Visual,
and functions very similar to a pivot Table. For those of you familiar with that feature of Excel.
Before we do the Matrix though, we just need to quickly add a new page to this Report and make
some minor changes to it.
So down to our page tabs, I'm going to right-mouse click and duplicate the Yearly Variance
page. I will name this new page By Country as I want this Reports to drill down to more
information on the sales from a specific country. And because of that, coming up to the pages
Visualizations, I want to change the Slicer from a Year to a Country. So if I click on that Slicer,
and over in the Visualizations pane, I will remove the Year Field and replace it with the Country
Field, Country Table. And let's bring Country in it.
So now I have a nice dropdown where I can choose a specific country such as France. And this
works quite nicely the Column Chart and the Number of Orders Card are doing good jobs.
However, the KPI and the Line Graph are not really working, because they need a year to be
selected to really make sense. And I don't have that work in at the moment, and I'm not planning
to. So I'm going to remove the Line Graph. And I'm also going to remove the KPI. But I'm going
to replace that KPI with the Total Revenue Card that we had earlier.
Now rather than create that again, I'm actually going into the Summary Report page at the
bottom, because I have that exact Card on here. And I will simply take a copy of that Card, copy
the Visual and come back over to the By Country Report page. And I'm going to click the paste
button on the Home tab. And it will paste it in the exact same place that it was on the Summary
Report page. And because the layout of these Report pages is consistent, that is exactly in the
right place. In France 355,729 Total Revenue. So this is working nicely.
Coming back up to that Slicer, where I currently have a dropdown, which makes sense because
we have quite a few countries, I don't really want the list format that we saw in an earlier lesson.
But I would like the opportunity to choose more than one country. So as a recap, coming over to
the Formatting Section, and opening up Selection controls, I'm going to remove the Single Select
option. So that now if I came back to that Slicer, in the dropdown, I could select Belgium as
well. And click away and view Belgium and France at the same time combined. And this is just
demonstrating what is possible.
I'm actually going to change that in the later lesson. But a nice recap that these Slicers can be a
Single Selection or a Multiple Selection. And at the moment, we have a Multiple Selection going
on in there. However, I'm just going to switch that back to one country for simplicity for the
moment. So we can now look at bringing in the Matrix Visual. So over to the Visualizations
pane, and the Matrix is this one here just next to the R.
And if we click the Matrix and drag it into position, just as we have been doing with the other
lessons, and I'm going to make it about this size. I can always adjust it if that's not quite right.
But the goal of this Matrix is I would like to see the Revenue for all of the Locations of the
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country selected in the Slicer. And I'd like to see that Revenue over every year. Let's make sure
that Matrix is selected and let's drag the Location Field into the rows area. As I mentioned
earlier, this is just like a pivot Table for those of experience there. And it will list all of the
Locations from the selected country, which is France, we have four Locations for coffee shops in
France. Then I'm going to bring the year into the Columns area.
So they will come across into Columns, we know we have those four years; 2016 to 2019. And
then the Total Revenue Measure will go into that Values area. So now we have the Values for all
of the years and all of the Locations. Now let's make some Formatting changes, to get this Matrix
exactly how we want it. So if I click on the Formatting button, and I'll begin with the Font. I’m
going to make the Font a little bit larger, now we've got 3 areas to change that Font.
To begin with, we have the Column headers, which is the names of the years, and the words
Location and Total. They're currently 10 points. I'm going to increase that to 12. And then repeat
that process for the Row headers. So if I collapse the Column headers section, open up Row
headers, and find the Font, here it is 12 points. Once again, tons of settings in here, and then we
need the Values themselves. So scrolling back up, collapse Row headers, here’s Values, and that
will also be 12 points.
And then a little bit of resizing so that fits in, make it a little bit larger, because some of the other
countries might have bigger Location names. And I have to bear that in mind that I've got France
at the moment. But when we change country, we're going to have a different story being told.
Let's come and add a Border to this so that it matches our other Visuals. I won't worry about the
gray Background, because I quite like the white Background here. And that it has the banded row
colors, the alternate row coloring, so I don't want the Background. But the Border, I will.
Border on, that will clearly define where the Matrix starts and finishes. And 3 pixels as is usual.
Now that I've set that defined area, one thing I need to consider, just like with the width of the
Locations, the number of characters in their name, I also have to consider how many Locations
there are. So in France, we've got four, but the country where we have the most shops, the most
Locations is the US. So if I select the USA from the countries, because I know that's where we
have the most shops, and now I know how big to make this Matrix. And I need to make this a
little bit larger because they don't fit in. So let's select it.
And where do we need it? Here seems to be the winning place. And I've got a scroll bar at the
bottom. So those names are a little bit larger, and need to be a little bit wider as well. Now, I
don't want to spend too much time on this. But you can see what I'm talking about here, just
making this fit as best we can, if we can. Certainly use it, doesn't have to scroll, and also that no
information is missing. So that I'm happy with for the moment.
The final change in this Matrix is that rather than being sorted by the name of the Location,
which it is at the moment, I would like it sorted by the Total. Now as I move my mouse over the
Total Column header, an arrow will appear indicating that I can sort that. So if I click it, it is now
sorted in descending order; largest Value to smallest Value by the Total. So we have Boston
followed by Kirkland, as opposed to the A to Z order it was in a moment ago.
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So lots of Formatting changes to get your Matrix working for you. They can show a lot of
information in a small area. So we can see all of the Revenues for all years, all Locations in the
country selected in the Slicer.
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Video: Table
Alan: The final Visualization I would like to look at in this course, is going to be the Table
Visualization. And that is very similar to the Matrix. What I would like to use this Table for is to
show the Top 8 performing Products for the selected country, as that is a really cool use of these
Tables.
So to start with, I want to click somewhere on my Report page to deselect any Visuals, and then
in the Visualizations pane, click on the Table button and drag that tile into position, which will
be somewhere down here. It won't need to be as wide as the Matrix. And then to get it working.
So I want 3 Values, 3 bits of information in this Table. So coming over to the Fields pane, I want
the name of the Product. So in the Products Table, Product name. And then I want the Total
Revenue. So that can come into Values.
And then I want the Number of Orders, that can go into Values too, and this is what we have at
the moment. So clearly, there's not enough room. Although I would like to reduce this to only the
Top 8 when I'm done. They're sorted in order by Product name, just like the Matrix is sorted by
Location by default. And I have the Revenue of Number of Orders just like I would desire.
Now, rather than being in order by the Product name, I would like them to be in order by Total
Revenue. So if I click on the Total Revenue header, that will sort it by the Revenue instead. So
for USA, the currently selected country in the Slicer, we have Green Tea followed by Apple
Juice, and I can see the Number of Orders for them. So it can actually see that Still Water outsold
Apple Juice. But because of the pricing, Apple Juice still brought in more Revenue just about.
I would like to do a quick couple of Formatting options to this Table. So clicking on the
Formatting button, I want to add the Border. So Border on, 3 pixels. But then I want to remove
the Totals at the bottom. So find the Total Category. Here it is, and Totals off, that will give us a
little bit more room to work with. But also I just don't see the need for that, because we have the
Total Revenue on this page in a Card Visual. And also, we are about to change this to only the
Top 8 Products.
Now to do that, we are going to use this Filters pane, which sits to the left of the Visualizations
pane. If for some reason you do not see that Filters pane at the moment, it might be that it is
collapsed. So if I clicked this arrow on the right of it, it would collapse. And I can click the same
arrow to expand. Or it might be that it's hidden. If you cannot see it there, you will want to click
on your View tab up on the ribbon where there is a Filters button to bring that in to view. Now
for me, it's already there.
So coming over to it, we can filter by the Visual, which is what we want. And it lists the 3
different Values I'm using in the selected Visual, which is the Table. Now I want the Top 8
Products. So I'm coming into the Product Value, I'm going to use the little dropdown arrow to
see what filtering options I have. And there's quite a lot going on here. It’s currently set to the
Filter type, Basic Filtering. Let's look at changing that to the brilliant Top N Filters.
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If I select that, it will ask me how many? And would I be interested in the top or the bottom? So
it's called Top N. But you could find the Bottom 5 or the Bottom 8, if you prefer. I'm keeping it
as Top and I will type 8, but we could put any Value in there, Top 20, top 3, whatever works for
you in your Report. By Value, how is it deciding what the Top 8 are? Now it's going to be by the
Revenue. So I'm going to do Write the Total Revenue Field into the box provided.
Now you can see there that although I am putting Total Revenue, and also sorting the Table by
Total Revenue, and yes, that makes sense to do so. But you could filter it for a different Value
than what it’s sorted by. I can even filter it by a Value that is not even included in the Table.
Now, I think doing actions like that can be confusing for the reader. But we have that
functionality.
Now I've chosen Top 8, maybe it would have made sense to choose Top 6, because I can only
see 6 on my page and I'll need to make some adjustments to make this work. I do have a scroll
bar. So maybe I don't need to, but I would certainly like to. As I scroll down at the moment, I
have a lot more than 8. So this doesn't seem to be working. But that is because with the Filter
pane, we have to apply the filter. So looking back over to it, there's a little Apply filter button
underneath, something that we don't need to do with filters, such as Slicers. So it's very easy to
make that mistake or to forget.
Everything you do in Power BI, just check it before you go any further. Click Apply filter, I can
only see the Top 6, but now if I scroll down, there's the extra two. Not ideal to have a scroll bar,
although also not terrible. But to take this further, if I just resize this Table to include the 8, the
scroll bar will happily disappear. And then if I want to improve this a little bit, I guess I could
resize this Column Chart just to snap into alignment. If we had the time, which we don't really on
this course, we would dedicate more time to perfecting how this looks and feels. But for the
purpose of now, that does a job.
We want to focus on the functionality of the Visualizations really. And what we have is the Top
8 selling Products for a country that is selected in the Slicer at the top of the page. So if I did
change that Slicer from the US to New Zealand, then now I can see the two Locations we have
there and their sales over the years from the Matrix in the previous lesson. And also the Top 8
selling Products. And a winner for our New Zealand shops and customers is the Chocolate Chip
Muffin.
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Video: Practice Exercise
Alan: Hello and welcome to the practice exercise for the module on adding Visualizations to
your Report. Go ahead and open file, 5-9-practice-exercise and follow the instructions provided.
There is a completed version of this Power BI file named 5-9-practice-exercise-complete for you
to check your work against. Have fun.
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Section 6 – Textboxes and Shapes
Video: Textboxes and Shapes
Alan: In this lesson, I want to add some design elements to our Report pages. Now, we are going
to be keeping it simple. But hopefully it will show some possibilities, and also some key
features. Because it is important to make your Report nice to look at as well. You can have it
functioning correctly and showing the correct values. But if people find it difficult to read, or if
they find it ugly, then you're not going to get the same experience from them.
So in this lesson, I want to add a simple banner at the top of my pages. But in the next couple of
lessons, we'll look at some more specific features to improve in its design. Now, up on the
ribbon, we have an Insert Tab. And on this Insert Tab, we can insert Textboxes, Buttons, Shapes,
and also Images as elements. So you can insert an image as your company logo, which is pretty
cool. I want to insert a shape at the moment as a banner for the top. So if I click on Shapes, I will
choose a rectangle, and I'll begin just by resizing this rectangle so that it covers the entire width
of my Report page.
Let's make sure that's aligned with the revenue card. So a rectangle at the moment, it has a line
around it, a blue line, and it has this gray fill color. Let's change some of that over into the
Format Shape Pane. Because this is not a Visualization, so it's not a Visualizations Pane, it’s a
Format Shape Pane. And I have the option for Line. If I expand Line, there is that blue color, you
might think that's a Border, that's not a Border it’s a Line. We do have a Border setting in this
Format Shape Pane as well. And you can see this gets confusing. This is a Line, I'm going to
change the weight to zero, I don't want it.
And then if I collapse the Line section, we then have Fill. So, that gray is not a Background,
which you might think it is. Because in the other, Visualizations are usually a category called
Background, that is a Fill. I’m going to switch that off. I find it frustrating that the Fill doesn't
quite reach the ends of the shape. So I'm going to switch off the Fill. And instead of the Fill, I'm
choosing Background, I'm switching the Background on and I'm changing the color. And instead
of the gray color, let's do something a little bit more out there, I might go for this nice, faint
yellow color. And that can be our banner at the top.
Okay, so let's imagine I'm happy with that. But there's plenty more Settings to explore. And now
I want a Textbox as the title or the header for this Report page. So up on the Insert Tab, it's
Textbox, the Textbox has appeared in the bottom right corner of the Report. So Power BI found
that bit of space down the bottom, and thought that'd be a good place to put it. I'm going to grab
that Textbox and drag it up so it's over the banner I’ve created. Let's resize that a little bit like
this. And then let's type something in there such as By Country, a nice simple header for the
moment.
I'm on the By Country Report page. I don't want it to be Segoe UI, I want Arial Black and font
size, what would be good, 16? Maybe a little bit more 24. Yeah, that's great. Now, that's what I
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have at the moment. Hang on, where did it go? Where's my Textbox? Here it is. As I click away
from the visual, it came back and it's got a white Background. I want that to be the same as my
banner. If I click back on there, over to the Visualizations Pane, and expand the Background
category, and I don't want white, I want the same yellow color so that it looks like it's part of the
banner. And then coming back to that Textbox, I just want to move it so that it is definitely
centered on this banner. And there, you see that red dash line indicating that that is exactly in the
middle of that banner. So that is excellent. That is what I want.
But something you may have noticed is where is the Slicer? I had a Slicer on here, where I
selected the country of New Zealand, and I'm looking at their information on this Report page.
But now I don't see the Slicer , because I stuck the banner in a Textbox over the top of it. So how
are we going to change that? Well, there is a brilliant feature in Power BI called the Selection
Pane. And if I click on the View Tab, here, we have the Selection Pane. I’ll give that a click.
This is excellent. It lists all of the objects that are on this page. And we can show and hide them,
we can change their order, lots of cool things from here. Now I want to change the order.
So I can see the Textbox, I can see the Shape, which is the banner, and I can see my Slicer. I'm
going to select the Slicer, and drag it up to the top of this list. And there it appears on my page. It
still has its white Background. So with the Slicer selected, because not only can I move it here by
selecting it here, it's called the Selection Pane for a reason, saves me having to find the visual
and click it on the page. I could just click it in this nice little list. And now in the Visualizations
Pane, let's come into Formatting. And I'm going to change the Background to the same yellow
color. And because it then makes it hard to see maybe the size of it, I'm going to stick a Border
around my Slicer. So there it is.
So we have that now for the By Country page. But I want that banner on the Summary, and a
Yearly Variance page as well. So using the Selection Pane, if I click on the Textbox, hold down
the Ctrl key and select the Shape, I can then use the Home Tab to take a copy of those selected
items, change page to Yearly Variance, and paste those objects on there. Then move over to the
Summary page and paste them on here as well. And then just like we did on the initial page,
change the order so that this is working. So if I click somewhere on this page, the Textbox and a
Slicer are not showing.
So over in the Selection Pane, let's reorder them, let's put Textbox towards the top and Slicer
towards the top, both above the Shape now so they show themselves. Do a quick bit of
formatting to the Slicer, so let's drag it into play. Come over to the Formatting and set the
Background as the yellow and the Border as a free pixel. Everything is nice and consistent. Now
I have an error message next to the Slicer header, just complaining that the font size is not
enough, and I have to reduce it. But that's not necessarily a problem and I'm going to ignore that
for the moment. I think the Slicer works okay. Let's move over to the Yearly Variance page and
just do the same thing.
So I need to move the Slicer above the Shape and the Textbox above the Shape. And then with
the Slicer selected, its Background as the yellow, and Border is on three pixels. So apologies if
that was a little bit repetitive there doing it for two more pages. We also need to now go and
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change the Text. Because my Yearly Variance one says By Country, but getting these design
principles in place is going to have a big impact on your Reports. So, it's worth dedicating that
time to doing this. And these are nice simple changes.
Let me just name this one Yearly Variance, that needs a little bit resizing to fit that text in, and
then Summary. I'll just quickly rename that Summary, and our Report Design for the purpose of
this course is done.
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Video: Themes
Alan: In this lesson, we are going to look at Power BI Themes. Now Themes are brilliant when
it comes to designing your Report, because they can instantly apply some default colors, and
other formatting, to all of the visuals of your Report. Themes are found on the View Tab.
So if I click on View, there is a Themes gallery on the left-hand side, and I can expand it with
this little arrow. And as I hover my mouse over these Themes, I will see their name. So this is the
default Theme. Here we have Bloom, here we have City park. And each one will apply a bunch
of formatting, such as colors and fonts and icon sets, to your visuals. So let's have a look at one.
Now some of these Themes are quite impactful. For example, this one here is Innovate. And if I
click on that, it will make a huge impact to this Report, with Background colors and Font colors,
and quite a lot going on. But if I pop back up to Themes again, some of them are a little bit
softer, such as this one here, which is Temperature. And if I click on this, this is the Temperature
Theme, no Background color on the page, and a bit of a softer approach to your Report Design.
But it keeps that consistency, I can see my Map and my Column Chart, both for using that same
color, and saves me doing that manually myself to every visual and every page of this Report.
Now if a pop back up to the Themes gallery again, in addition to the Themes available, there are
more options underneath that gallery. First of all, we have Browse for Themes. So you may have
downloaded a Theme, or you may have created one, or you may have been sent one by a
colleague, or a friend. And I could browse for these Themes that I have stored somewhere and
import them into this file. We also have the Theme gallery. And these are a gallery of Themes
created by the community that you can use. Let's have a look because there's some really good
ones in here. So this is the Power BI community Themes gallery.
And if you're short on time, or you don't have the inclination to go and create your own Themes,
and there's some really good Themes in here, we can see we have some categories at the top. So
at the moment, these are the Featured Themes, but I could choose those with Top Kudos. Or I
could look at those that are recently posted, or come into All Themes and starts looking through
different categories from this list. If I come back to the Featured Themes, and let's have a look at
one of these, such as the Autumn Theme, which is provided by Amanda on the Microsoft team.
As I come into here, I will get a glimpse of that Theme in action. Here it is, an example of what
it would look like.
And as I scroll down, I have access to the JSON file, which is Theme. If I click to download the
JSON file, and let me just go and save this somewhere, such as my Documents folder. And now
let's go in import it to our Power BI Report. So expand the Themes gallery, browse for Themes,
I'll navigate to my Documents folder, and there is the palette seven, my downloaded Theme. I'll
open that up. The import was successful. And this is it applied to our Power BI Report. It’s quite
nice. If I liked this Theme, but I didn't like everything about it, we could come back up to the
Themes gallery and look at customizing this Theme. And just doing some minor tweaks because
maybe it wasn't 100% what we wanted.
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Now I have Customize current Theme available here. If you do not have the option available,
then you might need to come into File and Options and then Options again, and then we have the
Preview Features category, discussed earlier in this course. And I have the box checked to
Customize current Theme as a Preview Feature. If you don't see the ability to customize, you
might have to come and check this box. But also, please bear in mind that Power BI is updating
all the time. And at some point, it may not be in this list. And it may just be a standard feature,
and you won't have to worry about it.
But some really cool features you can preview before they become the norm here. Customizing
the current Theme is one of them. So if I came back into the gallery, Customize current Theme, I
can now get involved and edit some of these colors that have been used. You can see this is the
color applied to the Column Chart. We also have the Text categories, I can change that default
Font, and the default Font size.
We have settings to change how it affects our Cards and our KPIs, which we have used on every
page of this Report. I've got some visual settings, some paid such as the Background color you
saw on the first Theme that I demonstrated. You can even format the Filter Pane, which we saw a
couple of lessons ago. But I'm not going to worry about customizing this Theme, so I can cancel
that.
But if I did make some further customizations to this, that would affect this file. But I could also
come in to the Themes gallery, export that Theme as a JSON file, and then use it again in more
of my Reports, but also share it with other colleagues and friends in the Power BI community.
I'm going to keep the Theme I’ve got here, nice and quick. If I look at another page, I can see
that that has taken control of the entire Report. And the big thing about these Themes are saving
time for us manually doing formatting. But also keeping that consistency across all the visuals,
and all of the colors, and all of the Fonts of our Report.
It may not be completely what you want, I'm not that pleased with the Data labels that have been
used in my line graph and my Column Chart here. I could change that right now. But more
importantly long term, if you're creating a lot of Reports in Power BI, you can customize that
Theme so that in the future your life is a lot easier.
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Video: Conditional Formatting
Alan: In this lesson, I want to look at the Conditional Formatting feature in Power BI. This is
such a useful feature to highlight key values, or metrics in your Reports. And we can apply
Conditional Formatting roles to almost any visual. So for example, if I change page to the By
Country page, which is where we have our matrix and our table, and if I select the table visual,
and over in the Formatting section of the Visualizations Pane, there is a setting for Conditional
Formatting. So nice and easily available.
And there are a few Conditional Formatting options in there for us. I can see we have Font color,
we have Icons, but at the moment, these are the options based on the product value. If I change
the dropdown from Product to one of our measures, like Total Revenue, now we've got even
more options, such as Data bars, which are very popular. Now, if I was to select Data bars here,
and switch that on, it doesn't look that great or that useful, because of how similar these values
are. So I'm not going to keep it. But I want to demonstrate how to get to the Settings. Because in
a different scenario, this can have huge impact.
There is a link for advanced controls. And if I clicked on that, I'd be able to take these Data bars
further, I could show you the bar and not the value, I could even change the min and max axes.
So not a very good example here, but if I did drag this window to the side, I can see the values
behind it. And if I changed the minimum axes, from lowest value to a custom value, and I put
that custom value as 7,100 and clicked Ok, then this is a better example of what Data bars can
do. Now I repeat, it's not something that I would do here, I'm not going to come in and manually
type 7,100. Because these values are dependent on the customers in New Zealand.
And when this Report changes, typing 7,100 is probably not going to be that helpful. But I
wanted to demonstrate that here to show you what these Data bars look like. Because they're a
very useful visual tool. I'm going to come back over and turn those Data bars off. And let's
switch back to the Summary Report page because we can also apply Conditional Formatting
rules to our Charts. So if I select this Column Chart for the category sales, over into the
Formatting section on the Visualizations Pane, but this time, you notice there is no Conditional
Formatting option.
Now, I don't know why this is the way it is, but it's very hard to find Conditional Formatting. It’s
not going to be hard here, because I'm going to tell you where it is. But if it wasn't for this
course, for some reason, it's very secretly hidden. You need to come into Data colors, and I still
don't see it. But when I move my mouse over Default color, these three dots appear on the right.
And if we go into those three dots, here is Conditional Formatting for the Column Chart. If I
click on this, a window appears where we can apply Conditional Formatting based on the Color
scale.
Or, I can change that and set up my own rules. So if the column is above 50,000, then this is the
case or whatever my rules might be. For a quick demonstration, if I leave it as Color scale, based
on the revenue, but what's pretty cool here is that even though the revenue is used in the Chart, I
can create a Conditional Formatting rule based on a field that's not used in the Charts. So a little
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bit like the tooltips, I'm able to convey more information than what the Charts on its own can
offer. The Column Chart compares values by the size of the column. But by adding this text into
tooltips, and now these colors based on Conditional Formatting rules, we're getting more from
our Charts.
I will leave it as Total Revenue, as I've mentioned on an earlier lesson. Although that is pretty
cool, it can also be confusing unless you can explain to your audience somehow why that color is
the way it is. Let me change these colors from blue, nothing wrong with blue. But for something
different. Let's throw a bit of pink in here, I'll go for the lightest one. Over here, I'll go for the
darkest one. And if I click Ok, we have a Color scale with those values. So Beverages and Food
are very similar. So they're that strong color. Whereas pastries is a little bit further behind so it’s
that lighter color.
There's only three columns here so these Color scales are not making a huge impact. But there
are better examples out there. That is nice, though, I'm going to keep that. But over in my Map
visual, for one last example, we can also do Conditional Formatting to Maps. If I click on this
Map visual, over to the right is a very similar story. Formatting section, Data colors is already
expanded, move your mouse over Default color, there's the three dots, Conditional Formatting.
For this example, I'm not going for a Color scale, let's set up a rule.
And for a quick example, this rule will be not the count of country, but it will be if the Total
Revenue, the value is greater than or equal to, let's say 100,000. And that is a number not a
percent. And less than, I don't really care what it's less than, so I'm going to put an outrageous
number in like 900,000. And the color will be a nice green. So I'll click on Custom color. And I
can select from this palette, or I can type in a hex reference which I've got, which is 107c41. And
if I apply that and click okay, now, those countries that are greater than or equals £100,000 in
Total Revenue are shown in green, so I can see Australia hit that target.
And if I zoom in on Europe, I can see that Denmark, Poland, France, have also made it whereas
Austria and Ireland, etc. didn't quite make it. So a nice extra bit of visit there on our Charts, and
also our tables using Conditional Formatting.
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Video: Practice Exercise
Alan: Hello and welcome to the practice exercise for the Report Design module. Go ahead and
open file 6-4-practice-exercise and follow the instructions provided. There is a completed
version of this Power BI file named 6-4-practice-exercise-complete for you to check your design
work against. Have fun.
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Section 7 – Edit Interactions
Video: Edit Interactions
Alan: In this lesson, we are going to look at editing the Interactions of your Visuals. And this is
very important, because first of all, it's a really powerful feature of your Power BI Visualizations.
But second of all, it's a feature that if your Report users are not familiar with, it can create great
confusion when they're trying to read and use your Reports.
So this is what I mean, I have this Report page, the Summary, Report page on screen. And if I
was to click one of the countries, such as New Zealand here on the Map, as I do that, it affects
the other Visuals on the page. Both Cards now show the information for New Zealand. And the
Column Chart on the left, as highlighted in the columns, the contribution from the customers in
New Zealand. So that's pretty cool functionality. But you can imagine, if a user was to click on a
country not knowing that kind of effect would take place, that can be very confusing, and also
frustrating for them.
So we need to decide, and then manipulate if and how our Visualizations affect the other
Visualizations on a page. Now, first of all, for me to remove the fact that I clicked on New
Zealand, I would just click anywhere else in this Visualization. So if I just click on Asia, where
we don't have any shops, that clears that selection, and now the Report is back as it was. So as an
example of editing these Interactions, looking at the Column Charts on the left, I don't want the
Column Chart to affect the two Cards above it for Total Revenue and Number of Orders. I do
want it to affect the Map, but not the Cards above it.
So if I click on my Column Chart, so it is selected, up on the ribbon, we have the Format tab.
And on the far left of the Format tab, a button called Edit Interactions. If I click that button, it
just toggles the feature on. So now, when I look at the Visualizations on my page, they all have
little buttons in the corners. I can see the two in the top right of the Cards, one in the top right of
the Map, and one in the bottom right of the Slicer. And even one in the top right of the Textbox
as well. Now, I've decided that I don't want me clicking a column such as Food to affect the two
Cards above.
Because I know that if I hover my mouse over a column, I can get that information from the
tooltip. So in the corner of those two Cards, there is a None button. The other button is to enable
the filtering, which is already in play. So I'm going to click on None for the Total Revenue Card.
Then I'm going to click None for the Number of Orders Card. And I'm going to leave it to affect
the Map and the Slicer and so on. Now keeping the Edit Interactions button on, I'm going to click
on the Map Visual.
So now I can decide how the Map affects the other Visuals. For this, I'm also going to click on
None for the two Cards. Because once again, I can get that information by hovering my mouse
over the tooltip. So maybe that's unnecessary. You can make whatever decisions you want. But
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I'm interested in the Column Chart here because that has the three options. We have the None
option to disable the highlights from before, but I quite like it to affect it or interact in some way.
The other two options are to perform a Highlight, which is what it's currently doing, where if you
click on a country, it highlights the portion of the Column Chart. But I don't want that, I want the
other option, which is to Filter the column. That I much prefer to the highlight. So if I click on
Filter, now, when I choose a country like Australia, it filters the Column Chart instead of
highlighting a portion. And that's great. So you can see here that different Visualizations also
have different options.
The Cards will have a simple filter or no filter, whilst a Column Chart has the option to filter,
highlight, or nothing. Just before I leave this Report, looking at the Column Chart, I'm now not
so much a fan of the auto number format. Because the numbers for Beverages and Food are very
similar. So I'm going to come back up to the Format tab and turn off the Edit Interactions and all
the buttons on those Visuals disappear. I'm going to select the Column Chart, come over to the
Format section of the Visualizations pane, open up the Data labels section, and change the
display units to None. And I'm going to set the decimal places to zero. And I think the Column
Chart looking like that is much better.
So when I click on another country in the Map, such as France, when those Food and Beverage
values are so similar, I can now see the difference more clearly. So a few Visualizations here.
But let's change to the Report page By Country. On here, we have a Table and the Matrix. And
these can also filter the Visualizations on your page. So in that Top Eight Product Sales Table, if
I clicked on the cheese and pickle sandwich that then filters or highlights all the Visuals on the
page. So pretty cool. I do love this functionality. But it doesn't always make sense. So we can
see, the two Cards are affected.
But that's kind of unnecessary, because the Top Eight Table shows us that information. I can see
the Column Chart is affected. That's kind of pointless because the cheese and pickle sandwich
belongs to one category Food. So obviously Beverages and pastries would be zero, then you
have the Locations Matrix above. So maybe that's useful if you wanted your Report to behave in
that way. Remember, to clear an Interaction, just click on the cheese and pickle sandwich again,
and that would remove it. With that Table selected, up we come to the Format tab over to Edit
Interactions, all the buttons appear on the Textbox, the Slicer, the Matrix, etc. I'm going to switch
off the Interaction for the two Cards, None and None.
And then the Column Chart as well this time is None, no point filtering or highlighting. The
Matrix I will leave on. Now if I click on the Column Chart Visual for one last example, to show
that on the Matrix and also the Table, we once again have those Interaction options. So if I
clicked on pastries, then I'm going to get the Top Eight, or Top Five in this case, because only
five products for pastries. And a Matrix will show the sales for the pastries. And then I can click
somewhere else on the Column Chart to remove that. So we do have the options here to disable
that functionality. So the Column Chart can't interact with them.
I'm going to leave it so it can maybe that's useful for our users to quickly drive to that detail. But
I wanted to show that whether it's a Chart, whether it's a Slicer, a Card, a Table, they all have
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some options for interaction. And by default, these are switched on. This is a great strength of
Power BI, this rich level of interactivity. But you also have to know about this. So when you're
setting up your Report, it works the way that you want it to work. And your recipients of this
Report are going to find it easy to use, and they're not going to get confused and get caught down
a rabbit hole where they've clicked on something and other Visuals are affected and they don't
know how to get out and they don't know why it's doing it.
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Video: Filter pane
Alan: Let's now look at the Filter pane. Now this is something that we did see in an earlier
lesson, because we used it to create that Top Eight Products Table. But I want to explore it a
little bit more now. So I'm on this Summary Reports page, and over to the right next to the
Visualizations pane, I can see my Filters pane. It's currently collapsed. So if I click the arrow at
the top, it will expand it, and I can see the options within it. I have a search box, the opportunity
to filter on this page, or to filter on all pages.
Now at the moment, they're the only two Filter options. But if I click on my Map Visualization,
now, I also get a filter in there for that specific Visual. And I can filter on all three fields that are
used in that Visual; the country, which is the location, the Total Revenue, which is used for the
size of the bubble, and a Number of Orders, which is actually in the tooltip. So you don't see it
on the Map unless you move your mouse onto it. But that is now also something we could use to
filter the Visual.
So for example, I could click on the Total Revenue filter and expand the options within it. And I
can create a filter for any value that is less than or greater than, the usual options in here, a
specific value. So maybe I'll put greater than or equal to, and I'll type 70,000. If I now click on
Apply a filter, that will filter the Map to only show the countries that have brought 70,000 or
more in. And you might have noticed some of them disappear from view. To clear that filter, I
can click the eraser button in the corner, and then they come back.
So a nice simple demonstration. That in addition to Slicers and Interactions, we also have this
Filter pane and we can filter by any of the fields used in that Visual. Now if I collapse that Total
Revenue, because there is also a box to add Data field here. So if I come over to my Filter list
and expand Products, and I drag Product into that Data field area, I can now use that as a filter.
So although that is information that is not in the Map Visual, I can use it for filtering. So if I
choose a blueberry muffin, that now filters the Map for only the sales of blueberry muffins, and I
could choose a butter croissant as well, and now it's filtering it for that.
So this could, in a specific scenario, have quite a great effect on your reporting capabilities. Now
if I come back up to the product field and clear it with the X, and I'm going to move that same
product field into the option to filter on this page. So now it's going to affect everything on the
page. So if I come and choose that blueberry muffin again, now it filters everything. So the Total
Revenue, Number of Orders, Cards are affected, the Map is but also that Column Chart, which
looks a little bit silly, maybe with just that one column.
But it's just a demonstration that everything that I've put on here, if I'd set it up to work with this
Filter pane, which in this example we haven't, but we're demonstrating its use. If I clear Products
from there, and it kind of speaks for itself, but if I drag Product into Filters on all pages, and now
go back to choose that blueberry muffin again, which is making me a little hungry, it not only
filters this page, but if I come over to the By Country page, it's now also affected this. Looks
rather ridiculous with the Top Eight Table only having that one product where some of the other
Visuals maybe do make some element of sense and use. But, awesome that there is a Filter
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option in here that can affect all the pages of your Report, all of the Visuals on a specific page, or
even just target one specific Visual. And this is all part of those rich filtering and interactivity
elements that comes with Power BI Reporting.
Now I'm going to remove that filter, I don't want that products filter behaving in that way
towards the pages. And now everything looks great again, and I have that Top Eight Product
Table and that Column Chart etc. The other Report page, we have, Yearly Variance is possibly
the best example in this Report of how we could use something like the Filters pane. This is all
set up to compare a year against that previous year. And we have that Slicer filter at the top to
choose that year. But I could come over to the Field list, and maybe bring in a country, which is
something that's not used in any of the Visuals on this page. And I could put that into the filters
on this page area.
So that now if I choose a country such as Belgium from there, now all of the Visuals are only
showing Belgium. So I can see in the year of 2019, that there was that 3.86% improvement in
revenue. And all of the other Visuals are also working with that. So that could be a way that we
use it in this Report, to have that optional country filter available in the Filters pane on the right.
I'm going to keep that filter there, but I'm going to click on the eraser to clear the applied filter of
Belgium, bring this back to all the countries. But I'm going to keep that filter there so that my
Report recipients have the capability to quickly filter for a specific country or countries if they
choose to.
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Video: Drill through
Alan: In this lesson, we are going to look at an awesome filter technique called Drill through.
And we want to use this on our By Country Report page. So if I switch to By Country, this is it, a
Report page, where we can filter by the country in the Slicer at the top, on the Report page
banner. And that's great.
But maybe we're going to change how the pages of this Report interact. And I don't want that
Slicer anymore. So I'm going to click on that Slicer, and press Delete on the keyboard. And it's
no longer there. And now I can't filter for that country, unless I use the Filter pane on the right.
But I don't want that. I'm coming back to the Summary page because I want that By Country
page to be a detail page, if you will for the Summary one.
I would like to choose a country from this Map Visual. And when I do it, it drills through and
filters the By Country page for the country that was selected on the Summary page. I hope that
makes some sense. If it doesn't, it's about to when we do it. So on the By Country page, over in
the Visualizations pane, underneath the Visuals, and the Field areas that we've been using on this
course, there is a section called Drill through. And there's a box in there to add a Drill through
field.
So coming over to the Filter area, I'm going to drag the Country field into that box. And as soon
as I do that, over on the Report page, it puts this button in the top left corner with an arrow. And
that button will take me back to the page, the source page that I Drill through from now you can
customize that button and use shapes for buttons and all kinds of other stuff but we won't go into
that detail right now. But that's what that button is going to do. I have it selected at the moment.
So on the Visualizations pane, I can see a whole bunch of formatting settings for that button.
I guess the one thing I might do is come into the Background section, and set the Background as
the same color as the banner. And then coming over to that button, it's going to drag it into the
banner, there we go, perfect. Now we can put that wherever we want, it doesn't have to be in the
top left corner. But if I leave it there, let's come over to the Summary page and see the Drill
through in action. Now you can Drill through from any Visualization now, that mentions a
country.
Now we only have one here, which is our Map. But if I had a Column Chart that had countries in
the axes, or a Table that mentioned countries, or anything like this, I could use that as my Drill
through as well. Any Visual that uses that Country field, the one that Drill through is set to use,
can now be used to Drill through to that page. Now we only do have this one Visual. So if I right
click on Canada here, I get the option to Drill through to the By Country page. And that will take
me to that page and filter the page for Canada. How awesome is that?
So we have this page, which is kind of a detail. We have a Summary page with a top-level
information. But then we can use this Drill through to find more information about an element, a
country in this case. But it could have been a Category or a Product or a Customer. It's a really
useful feature to build into your Reports. To go back to Summary, I could come up to this arrow
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button in the corner. As I position my mouse over it, it prompts me to hold Control and click to
go back to the previous page, being the Summary page. Absolutely fabulous. Now let's see that
in action one more time.
I'm going to right mouse click on New Zealand, Drill through to country, so now it's going to
Drill through and filter for New Zealand which is brilliant. But there's nothing on this page that
tells me this is New Zealand. Now yes, I might know that because the Matrix has got the
locations. And I may see Auckland and know that's New Zealand, but I want something clearer
than that. So the plan is to change that header that says, By Country to the name of the country
that we have filtered it by.
So I'm going to begin by getting rid of that Textbox by clicking the By Country Textbox, press
Delete, and it's gone. And the way we're going to do this, is to use a Card. Now a Card is
something we've seen in this course doing its classic job. In fact, we have them on this Report
page, showing the Total Revenue and Number of Orders. But if I come and bring in one of those
Cards again, by clicking the Visual, drag it where I want it, which is not there. And let's resize it
somewhat and center it, perfect. And now coming over to the Field list, I'm going to put the
Country field into the Fields area. And there is New Zealand, the currently filtered country.
Now that text is massive. So if I click the formatting section for this Card, into Data label, and
let's not have 40 points, let's say 30. Let's collapse the Data label. And I do not want that
Category, we're going to switch that off. And I do want a background to be the same color as the
shape behind it, excellent. Okay, let's see this in action. If I Control and click my arrow, takes me
back to the Summary page. Let's do something different. Let's zoom in on Europe. And let's
choose one of these European countries. Let's go for Austria. Right click Drill through, By
Country, which is the name of the page, and here we have Austria.
I can see the Information, Top Products, Sales of Categories, Number of Orders, everything that
we've designed. And also at the top, I can see what this has been filtered by. So I love this Drill
through feature. It's one of the more popular filtering techniques available in Power BI. So as a
wrap up for what we've done in just this course, the main filtering tools have been the Slicer, as
the most popular of them all, we've got the Interactions of the Visuals, the fact of clicking one
can filter another.
We then have the Filter pane, which can filter by Visual page or all pages. And we also have this
Drill through technique. A lot of different options. You can choose what works for you and how
you want to design your Report, and how you want it to be used. But it's great to have these rich
variety of different techniques.
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Video: Practice Exercise
Alan: Hello and welcome to the practice exercise for the module on editing Interactions and
Filters. In your Power BI Report. Go ahead and open file, 7-4-practice-exercise and follow the
instructions provided.
There is a completed version of this file named 7-4-practice-exercise-complete for you to check
your work against. Have fun.
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Section 8 – Publish
Video: Publish
Alan: In this module, we are going to publish our Report to the Power BI Service, powerbi.com,
and then look at a few different ways that we can share that Report with others. So we have our
finished Report here with three different Report pages. And on the Home Tab, there is a Publish
button.
Now before we do that, I could share this Reports with others by simply sharing this file in the
same way that you would share an Excel workbook or a Word document. I could just share this
file, and others who have Power BI Desktop will be able to open it and use the file in the same
way that we are. So that is an option. But we are going to publish this to the Service. Now before
I do that, it's important that we are logged in. I can see in the corner that I am logged in with my
account. So, make sure that you are logged in.
And if you do not have a Power BI account, then go to powerbi.com and sign up because you
need an account to use the Service. Okay, so I'm logged in already, if I click Publish, that will list
all of the workspaces that I have as a destination. I've just got the one, which is the default to my
workspace, which we immediately get when you've signed in for an account. But we can create
different workspaces for different types of Reports. If I select that, it will publish it to that
workspace, and we have success.
Now I can open that Report now in the Service through the link, I can also use the link to get
quick insights. Now, we're not going to get into that in this course. Because the Power BI Service
offers so much, we could dedicate hours of lessons to it. And this Power BI course is just an
introduction, but something that I recommend checking out. For now, I'm going to click the link
to open my Report in Power BI, and here we have it. So this is the Power BI Service, otherwise
simply known as powerbi.com at the time of recording this video.
And the look of it has changed recently. You can see at the top, I currently have the New look on
with this little toggle. So don't be surprised if it looks a little different because maybe you're
using the old look. Or maybe by the time you watch this, they may have made further changes to
it. Now it looks similar to the Power BI Desktop. Although you can see the pages are on the lefthand side instead of Tabs at the bottom. And I can navigate my pages by simply clicking them
there.
On the far right, we have the Filter Pane, just like we do in Power BI Desktop. And everything
that we've set up in our Reports will work. So on this Summary page, if I clicked a country, such
as the USA, then that will filter my Column Chart to the left. That interaction works in Power BI
Service the same way it works in the Desktop. And I can click the USA again to remove that
interaction. The Slicer at the top will work the same, I can drag the ends of that Slicer and filter
in my Report through that Date range. And if I change my page to Yearly Variance, I still have
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that filter in the Filter Pane from our previous lesson. And I can use that to filter for a country
such as Denmark. And I can see that take effect as well.
So this is pretty cool that we're in a browser that once we've published this, I could access from
anywhere where I have an internet account. I just simply go to powerbi.com, log in, and I have
access to this Report, which is fully interactive. And I can view it myself or could be showing
this Report to an audience in a meeting. At the top of the screen, we also have the date that this
was last updated. That is the 6th of May 2020, that's a UK date format. And we have a bunch of
Settings on the far left, that as I mentioned, we won't be able to explore in detail. But one of them
there is My Workspace, and also the option for Workspaces.
So My Workspace the default Workspace for me, which if I was to click to expand, I can see the
different Reports and Data sets and Dashboards that I might have in there. There's just one more
Reports called Sales and a couple of different Data sets. I could also expand the Workspaces
section above. And in here, I can go and look at creating a new Workspace, which I could then
invite and share with my colleagues if I need other people to access this Report in the same way
that I do. These are areas that are worth looking into.
But for now, we have published this Report successfully. And we can access this Report now
from anywhere through a browser. And we can access this Report anywhere now easily through
a browser. And we don't have to worry about having access to that .pbix file and having Power
BI Desktop software installed on the laptop or on the other device that we're using at that point in
time.
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Video: Share the Report
Alan: We will now look at some of the different ways that we can share this Power BI Report.
So we have mentioned sharing the .pbix file, and now we have it published, and we can get
access to this from anywhere. But along the Toolbar at the top, we have a few other options. To
start with, we have this Export button. And if I click on that, we have the opportunity to export
this Report into a PowerPoint file as a PDF, or to print.
Now with these three options, you do lose all the interactivity and the filtering aspects of your
Report. So, they are not necessarily the best options. But if you don't need people to be able to
filter or interact, or maybe you don't want them to, then they fit the purpose. They are also file
types that people are familiar with. To receive a PDF and to browse over a Report, people will
feel comfortable, and maybe not as intimidated by some of the other methods on show. So
although they lose functionality, they do have their advantages.
Next to the Export button, we have a Share button. So I can share this with other colleagues by
using that email, you do need a Power BI Pro license to do that, you do need a paid license.
Further along, we have this ellipsis, these three dots on the end. And there's also a few options in
there, we have the option to download the .pbix file. So if I was at a different location, viewing
this Report to my browser, but I didn't have the original file with me, if that was left back home
or on another device, then I could download the file here and now and share that. We have the
option to Analyze in Excel. Once again, that's just for Power BI Pro users.
But then we have this Embed option, which is a fantastic option. Because we can generate some
Embed code, and then we can Embed that into any public website or blog post or social media,
where it will accept some Embed code and then that will be easy to share with anyone whether
they have a Power BI license or not. One of the recent Power BI updates was that your Power BI
Admin will need to enable the use of Embed codes before this setting can be used.
Whereas in the past, anybody could generate these Embed codes. It’s now controlled by the
Admin, which might be yourself, it might be other people at your company, to try and control
how this Data can be used in public. So that is a setting that Admin need to enable in the Admin
Portal, then they can go and create these Embed codes, and we can use them. So if I clicked on
Publish to web, I have this Embed code ready to be used. I have a link which I can easily share
via email to anybody to view this Report with or without a Power BI account. And also this
HTML code to insert into a blog post or any website that I have access to.
So depending on what Data your Report is showing, it's a setting that you may need to be careful
if it's the type of Data that you don't really want the public to be viewing. But it's a brilliant
setting which gets us outside of worrying about whether we have a Pro license or any of the other
constraints around the way we share this file. So I'm a big fan of these Embed codes. I'm going to
close that for now.
But there's a few different ways there that we can share this Report from sharing the original
.pbix file. But the limitations will be that people need the Power BI Desktop software to be able
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to open it. Then we had those exports such as PDF and PowerPoint, lightweight, simple familiar
to everybody. However, they lose the functionality of the filtering and interactivity.
There's some Power BI Pro options, but then we had the Embed code, which will maintain all of
the filtering and the interactivity. That also will be easy for people to use, just following the link
or clicking things on a website. But it does bring it out into that public domain. And that's
something dependent on what your Report is that you might have to bear in mind.
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Video: Practice Exercise
Alan: Hello and welcome to the practice exercise for the Power BI Service module. Go ahead
and open the 8-free-practice-exercise, Power BI file. And there is one instruction for this
exercise, which is to publish the Report to the Power BI Service.
If you don't have an account yet, go to powerbi.com first, sign up for your free account, and then
you can publish this Report to the default My Workspace, workspace@powerbi.com. Have fun.
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Section 9 – Wrap Up
Video: Wrap Up
Alan: Well, that wraps up this Power BI introduction course. My name is Alan Murray, thank
you very much for your time. There's a lot more learning and Power BI adventures ahead of you,
as this course just gave you that introduction. And we covered some important and some
powerful techniques. And you can create stunning interactive Reports with knowledge from this
course right now.
But there is also a lot more for you to explore. Power BI, only came out in 2015, and it's
progressing so fast. There's always new features, new DAX formulas that we can get our teeth
into, and take our Reports even further. So don't stop learning now. Check out the Power BI
blog, or any more advanced Power BI courses that you can take. And maybe I'll see you again
soon.
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